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About This Guide

The following topics explain how to use this guide.

* Document Objectives, on page xlix

* Related Documentation, on page xlix

* Document Conventions, on page xlix

» Communications, Services, and Additional Information, on page li

Document Objectives

The purpose of this guide is to help you configure general operations for the Cisco ASA series using the
Adaptive Security Device Manager (ASDM). This guide does not cover every feature, but describes only the
most common configuration scenarios.

Throughout this guide, the term “ASA” applies generically to supported models, unless specified otherwise.

Note ASDM supports many ASA versions. The ASDM documentation and online help includes all of the latest
features supported by the ASA. If you are running an older version of ASA software, the documentation might
include features that are not supported in your version. Please refer to the feature history table for each chapter
to determine when features were added. For the minimum supported version of ASDM for each ASA version,
see Cisco ASA Series Compatibility.

Related Documentation

For more information, see Navigating the Cisco ASA Series Documentation at http://www.cisco.com/go/asadocs.

Document Conventions

This document adheres to the following text, display, and alert conventions.
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Text Conventions

About This Guide |

Convention Indication
boldface Commands, keywords, button labels, field names, and user-entered text appear
in boldface. For menu-based commands, the full path to the command is shown.
italic Variables, for which you supply values, are presented in an italic typeface.
Italic type is also used for document titles, and for general emphasis.
monospace Terminal sessions and information that the system displays appear inmonospace
type.
{x|y|z} Required alternative keywords are grouped in braces and separated by vertical
bars.
[ Elements in square brackets are optional.
[x]y]z] Optional alternative keywords are grouped in square brackets and separated by
vertical bars.
[1] Default responses to system prompts are also in square brackets.
<> Non-printing characters such as passwords are in angle brackets.
L# An exclamation point (!) or a number sign (#) at the beginning of a line of code
indicates a comment line.
Reader Alerts

This document uses the following for reader alerts:

Means reader take note. Notes contain helpful suggestions or references to material not covered in the manual.

Means the following information will help you solve a problem.

Caution

Means reader be careful. In this situation, you might do something that could result in equipment damage or

loss of data.

Timesaver

Means the described action savestime. You can save time by performing the action described in the paragraph.

Il  ASDM Book 1: Cisco ASA Series General Operations ASDM Configuration Guide, 7.9



| About This Guide
Communications, Services, and Additional Information .

A

Warning  Means reader be warned. In this situation, you might perform an action that could result in bodily
injury.

Communications, Services, and Additional Information

* To receive timely, relevant information from Cisco, sign up at Cisco Profile Manager.
* To get the business impact you’re looking for with the technologies that matter, visit Cisco Services.
* To submit a service request, visit Cisco Support.

* To discover and browse secure, validated enterprise-class apps, products, solutions and services, visit
Cisco Marketplace.

* To obtain general networking, training, and certification titles, visit Cisco Press.

* To find warranty information for a specific product or product family, access Cisco Warranty Finder.

Cisco Bug Search Tool

Cisco Bug Search Tool (BST) is a web-based tool that acts as a gateway to the Cisco bug tracking system
that maintains a comprehensive list of defects and vulnerabilities in Cisco products and software. BST provides
you with detailed defect information about your products and software.
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PART I

Getting Started with the ASA

* Introduction to the Cisco ASA, on page 1

* Getting Started, on page 17

* ASDM Graphical User Interface, on page 53

* Licenses: Product Authorization Key Licensing, on page 91

* Licenses: Smart Software Licensing (ASAv, ASA on Firepower), on page 141
* Logical Devices for the Firepower 4100/9300, on page 187

* Transparent or Routed Firewall Mode, on page 203

* Startup Wizard, on page 229






CHAPTER 1

Introduction to the Cisco ASA

The Cisco ASA provides advanced stateful firewall and VPN concentrator functionality in one device as well
as integrated services with add-on modules. The ASA includes many advanced features, such as multiple
security contexts (similar to virtualized firewalls), clustering (combining multiple firewalls into a single
firewall), transparent (Layer 2) firewall or routed (Layer 3) firewall operation, advanced inspection engines,
IPsec VPN, SSL VPN, and clientless SSL. VPN support, and many more features.

\}

Note ASDM supports many ASA versions. The ASDM documentation and online help includes all of the latest
features supported by the ASA. If you are running an older version of ASA software, the documentation might
include features that are not supported in your version. Please refer to the feature history table for each chapter
to determine when features were added. For the minimum supported version of ASDM for each ASA version,
see Cisco ASA Compatibility. See also Special, Deprecated, and Legacy Services, on page 15.

* ASDM Requirements, on page 1

» Hardware and Software Compatibility, on page 4

* VPN Compatibility, on page 5

* New Features, on page 5

* Firewall Functional Overview, on page 11

* VPN Functional Overview, on page 14

* Security Context Overview, on page 15

* ASA Clustering Overview, on page 15

* Special, Deprecated, and Legacy Services, on page 15

ASDM Requirements

ASDM Java Requirements

You can install ASDM using Oracle JRE 8.0. OpenJRE is not supported.

\}

Note ASDM is not tested on Linux.
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[l AsDM Compatibility Notes

Table 1: ASA and ASA FirePOWER: ASDM Operating System and Browser Requirements

Operating System Browser Oracle JRE
Internet |Firefox |Safari | Chrome
Explorer
Microsoft Windows (English and Japanese): Yes Yes No Yes 8.0
10 support
8
7
Server 2012 R2
Server 2012
Server 2008
Apple OS X 10.4 and later No Yes Yes Yes (64-bit |8.0
support version
only)
ASDM Compatibility Notes
The following table lists compatibility caveats for ASDM.
Conditions Notes
Windows 10 "This app can't run on your PC" error message.

When you install the ASDM Launcher, Windows 10 might replace
the ASDM shortcut target with the Windows Scripting Host path,
which causes this error. To fix the shortcut target:

1. Choose Start > Cisco ASDM-IDM Launcher, and right-click
the Cisco ASDM-IDM Launcher application.

2. Choose More > Open file location.
Windows opens the directory with the shortcut icon.

3. Right click the shortcut icon, and choose Properties.

4. Change the Target to:
C:\Windows\System32\wscript.exe invisible.vbs run.bat

5. Click OK.

0S X On OS X, you may be prompted to install Java the first time you
run ASDM,; follow the prompts as necessary. ASDM will launch
after the installation completes.
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Conditions

Notes

OS X 10.8 and later

You need to allow ASDM to run because it is not signed with an
Apple Developer ID. If you do not change your security
preferences, you see an error screen.

b “Cisco ASDM-IDM” can't be opened
& b because it is from an unidentified
o F developer.

Your security preferences allow installation of only
apps from the Mac App Store and identified
developers.

1. To allow ASDM to run, right-click (or Ctrl-Click) the Cisco
ASDM-IDM Launcher icon, and choose Open.

4 Chess.app Mar 21, 2013 2:14 PM 1

A
2 Cisco Jabber.app
| Contacts.app

Show Package Contents

Move to Trash

1 of 62 selec
Get Info
Compress "Cisco ASDM-IDM.app”

Burn “Cisco ASDM-IDM.app” to Disc...
Duplicate

Make Alias

Quick Look “Cisco ASDM-IDM.app”
Share >

Copy "Cisco ASDM-1DM.app”

Show View Options

Label:
x| = .

ariosz

2. You see a similar error screen; however, you can open ASDM
from this screen. Click Open. The ASDM-IDM Launcher
opens.

™ “Cisco ASDM-IDM.app” is from an

4 } unidentified developer. Are you sure you
° want to open it?

Opening “Cisco ASDM-1DM.app” will always allow it
1o run on this Mac.

Google Chrome.app downloaded this file on
December 4, 2013 from 10.E6.118.3.

7 . Qpen st Cancel

371053
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Conditions

Notes

Requires Strong Encryption license
(3DES/AES) on ASA

Note Smart licensing models allow
initial access with ASDM
without the Strong Encryption

license.

ASDM requires an SSL connection to the ASA. You can request
a 3DES license from Cisco:

1. Go to www.cisco.com/go/license.
2. Click Continue to Product License Registration.

3. Inthe Licensing Portal, click Get Other Licenses next to the
text field.

4. Choose IPS, Crypto, Other... from the drop-down list.
5. Type ASA in to the Search by Keyword field.

6. Select Cisco ASA 3DES/AES License in the Product list,
and click Next.

7. Enter the serial number of the ASA, and follow the prompts
to request a 3DES/AES license for the ASA.

* Self-signed certificate or an untrusted
certificate

* [Pv6

* Firefox and Safari

When the ASA uses a self-signed certificate or an untrusted
certificate, Firefox and Safari are unable to add security exceptions
when browsing using HTTPS over IPv6. See
https://bugzilla.mozilla.org/show_bug.cgi?id=633001. This caveat
affects all SSL connections originating from Firefox or Safari to
the ASA (including ASDM connections). To avoid this caveat,
configure a proper certificate for the ASA that is issued by a
trusted certificate authority.

* SSL encryption on the ASA must
include both RC4-MDS5 and
RC4-SHAT or disable SSL false start
in Chrome.

e Chrome

If you change the SSL encryption on the ASA to exclude both
RC4-MDS5 and RC4-SHAI algorithms (these algorithms are
enabled by default), then Chrome cannot launch ASDM due to
the Chrome “SSL false start” feature. We suggest re-enabling one
of these algorithms (see the Configuration > Device
Management > Advanced > SSL Settings pane); or you can
disable SSL false start in Chrome using the
--disable-ssl-false-start flag according to Run Chromium with
flags.

IE9 for servers

For Internet Explorer 9.0 for servers, the “Do not save encrypted
pages to disk” option is enabled by default (See Tools > Internet
Options > Advanced). This option causes the initial ASDM
download to fail. Be sure to disable this option to allow ASDM
to download.

Hardware and Software Compatibility

For a complete list of supported hardware and software, see Cisco ASA Compatibility.
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VPN Compatibility

See Supported VPN Platforms, Cisco ASA Series.

New Features

This section lists new features for each release.

\}

Note New, changed, and deprecated syslog messages are listed in the syslog message guide.

New Features in ASDM 7.9(2.152)

Released: May 9, 2018

Feature Description

VPN Features

Support for legacy SAML If you deploy an ASA with the fix for CSCvg65072, then the default SAML behavior is to
authentication use the embedded browser, which is not supported on AnyConnect 4.4 or 4.5. Therefore, to
continue to use AnyConnect 4.4 or 4.5, you must enable the legacy external browser SAML
authentication method. Because of security limitations, use this option only as part of a
temporary plan to migrate to AnyConnect 4.6. This option will be deprecated in the near future.

New/Modified screens:

Configuration > Remote Access VPN > Network (Client) Access > AnyConnect
Connection Profiles page > Connection Profiles area > Add button > Add AnyConnect
Connection Profile dialog box

Configuration > Remote Access VPN > Clientless SSL VPN Access > Connection
Profiles > page > Connection Profiles area > Add button > Add Clientless SSL VPN
Connection Profile dialog box

New/Modified options: SAML External Browser check box

New Features in ASA 9.9(2)/ASDM 7.9(2)

Released: March 26, 2018

Feature Description

Platform Features
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Feature

Description

ASAv support for VMware ESXi 6.5

The ASAv virtual platform supports hosts running on VMware ESXi 6.5. New VMware
hardware versions have been added to the vi.ovf and esxi.ovf files to enable optimal performance
and usability of the ASAv on ESXi 6.5.

We did not modify any screens.

ASAv support for VMXNET3
interfaces

The ASAv virtual platform supports VMXNET3 interfaces on VMware hypervisors.

We did not modify any screens.

ASAv support for virtual serial
console on first boot

You can now configure the ASAv to use the virtual serial console on first boot, instead of the
virtual VGA console, to access and configure the ASAw.

ASAv support to update user-defined
routes in more than one Azure
subscription for High Availability on
Microsoft Azure

You can now configure the ASAv in an Azure High Availability configuration to update
user-defined routes in more than one Azure subscription.

New or modified screens: Configuration > Device Management > High Availability and
Scalability > Failover > Route-Table

VPN Features

Remote Access VPN multi-context
support extended to IKEv2 protocol

Support for configuring ASA to allow Anyconnect and third party Standards-based IPSec
IKEv2 VPN clients to establish Remote Access VPN sessions to ASA operating in multi-context
mode.

IPv6 connectivity to Radius Servers

ASA 9.9.2 now supports IPv6 connectivity to external AAA Radius Servers.

Easy VPN Enhancements for BVI
Support

Easy VPN has been enhanced to support a Bridged Virtual Interface (BVI) as its internal
secure interface, and you can now directly configure which interface to use as the internal
secure interface. Otherwise, the ASA chooses its internal secure interface using security levels.

Also, management services, such as telnet, http, and ssh, can now be configured on a BVI if
VPN management-access has been enabled on that BVI. For non-VPN management access,
you should continue to configure these services on the bridge group member interfaces.

Distributed VPN Session
Improvements

*» The Active Session Redistribution logic, which balances Distributed S2S VPN active
and backup sessions, has been improved. Also, the balancing process may be repeated
up to eight times in the background for a single cluster redistribute vpn-sessiondb
command entered by the administrator.

* The handling of dynamic Reverse Route Injections (RRI) across the cluster has been
improved.

High Availability and Scalability F

eatures

Automatically rejoin the cluster after
an internal failure

Formerly, many error conditions caused a cluster unit to be removed from the cluster, and you
were required to manually rejoin the cluster after resolving the issue. Now, a unit will attempt
to rejoin the cluster automatically at the following intervals by default: 5 minutes, 10 minutes,
and then 20 minutes. These values are configurable. Internal failures include: application sync
timeout; inconsistent application statuses; and so on.

New or modified screen: Configuration > Device Management > High Availability and
Scalability > ASA Cluster > Auto Rejoin
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Feature

Description

Configurable debounce time to mark
an interface as failed for the ASA
5000-X series

You can now configure the debounce time before the ASA considers an interface to be failed
and the unit is removed from the cluster on the ASA 5500-X series. This feature allows for
faster detection of interface failures. Note that configuring a lower debounce time increases
the chances of false-positives. When an interface status update occurs, the ASA waits the
number of milliseconds specified before marking the interface as failed and the unit is removed
from the cluster. The default debounce time is 500 ms, with a range of 300 ms to 9 seconds.
This feature was previously available for the Firepower 4100/9300.

New or modified screen: Configuration > Device Management > High Availability and
Scalability > ASA Cluster

Show transport related statistics for
cluster reliable transport protocol
messages

You can now view per-unit cluster reliable transport buffer usage so you can identify packet
drop issues when the buffer is full in the control plane.

New or modified command: show cluster info transport cp detail

Show failover history from peer unit

You can now view failover history from the peer unit, using the details keyword . This includes
failover state changes and reason for the state change.

New or modified command: show failover

Interface Features

Unique MAC address generation for
single context mode

You can now enable unique MAC address generation for VLAN subinterfaces in single context
mode. Normally, subinterfaces share the same MAC address with the main interface. Because
IPv6 link-local addresses are generated based on the MAC address, this feature allows for
unique IPv6 link-local addresses.

New or modified command: mac-address auto
No ASDM support.
Also in 9.8(3) and 9.8(4).

Administrative Features

RSA key pair supports 3072-bit keys

You can now set the modulus size to 3072.

New or modified screen: Configuration > Device Management > Certificate Management >
Identity Certificates

The FXOS bootstrap configuration
now sets the enable password

When you deploy the ASA on the Firepower 4100/9300, the password setting in the bootstrap
configuration now sets the enable password as well as the admin user password. Requires
FXOS Version 2.3.1.

Monitoring and Troubleshooting Features
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Feature

Description

SNMP IPv6 support

The ASA now supports SNMP over IPv6, including communicating with SNMP servers over
IPv6, allowing the execution of queries and traps over IPv6, and supporting IPv6 addresses
for existing MIBs. We added the following new SNMP IPv6 MIB objects as described in RFC
8096.

« ipv6InterfaceTable (OID: 1.3.6.1.2.1.4.30)—Contains per-interface IPv6-specific
information.

* ipAddressPrefixTable (OID:1.3.6.1.2.1.4.32)—Includes all the prefixes learned by this
entity.
* ipAddressTable (OID: 1.3.6.1.2.1.4.34)—Contains addressing information relevant to

the entity's interfaces.

* ipNetToPhysicalTable (OID: 1.3.6.1.2.1.4.35)—Contains the mapping from IP addresses
to physical addresses.

New or modified screen: Configuration > Device Management > Management Access >
SNMP

Conditional Debugging to
troubleshoot a single user session

Conditional debugging feature now assists you to verify the logs of specific ASA VPN sessions
based on the filter conditions that are set. Support for "any, any" for IPv4 and IPv6 subnets is
provided.

New Features in ASDM 7.9(1.151)

Released: February 14, 2018

There are no new features in this release.

New Features in ASA

9.9(1)/ASDM 7.9(1)

Released: December 4, 2017

Feature

Description

Firewall Features

Ethertype access control list changes

EtherType access control lists now support Ethernet II IPX (EII IPX). In addition, new
keywords are added to the DSAP keyword to support common DSAP values: BPDU (0x42),
IPX (0xE0), Raw IPX (0xFF), and ISIS (0xFE). Consequently, existing EtherType access
contol entries that use the BPDU or ISIS keywords will be converted automatically to use the
DSAP specification, and rules for IPX will be converted to 3 rules (DSAP IPX, DSAP Raw
IPX, and EII IPX). In addition, packet capture that uses IPX as an EtherType value has been
deprecated, because IPX corresponds to 3 separate EtherTypes.

New or modified screen: Configuration > Firewall > Ethertype Rules.

VPN Features
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Feature

Description

Distributed Site-to-Site VPN with
clustering on the Firepower 9300

An ASA cluster on the Firepower 9300 supports Site-to-Site VPN in distributed mode.
Distributed mode provides the ability to have many Site-to-Site IPsec IKEv2 VPN connections
distributed across members of an ASA cluster, not just on the control unit (as in centralized
mode). This significantly scales VPN support beyond Centralized VPN capabilities and
provides high availability. Distributed S2S VPN runs on a cluster of up to two chassis, each
containing up to three modules (six total cluster members), each module supporting up to 6K
active sessions (12K total), for a maximum of approximately 36K active sessions (72K total).

New or modified screens:

Monitoring > ASA Cluster > ASA Cluster > VPN Cluster Summary

Monitoring > VPN > VPN Statistics > Sessions

Configuration > Device Management > High Availablility and Scalability > ASA Cluster
Wizards > Site-to-Site

Monitoring > VPN > VPN Statistics > Sessions

Monitoring > ASA Cluster > ASA Cluster > VPN Cluster Summary

Monitoring > ASA Cluster > ASA Cluster > System Resource Graphs > CPU/Memory

Monitoring > Logging > Real-Time Log Viewer

High Availability and Scalability F

eatures

Active/Backup High Availability for
ASAv on Microsoft Azure

A stateless Active/Backup solution that allows for a failure of the active ASAv to trigger an
automatic failover of the system to the backup ASAv in the Microsoft Azure public cloud.

New or modified screens: Configuration > Device Management > High Availability and
Scalability > Failover

Monitoring > Properties > Failover > Status
Monitoring > Properties > Failover > History
Also in 9.8(1.200).

Improved chassis health check failure
detection for the Firepower chassis

You can now configure a lower holdtime for the chassis health check: 100 ms. The previous
minimum was 300 ms.

New or modified command: app-agent heartbeat interval
No ASDM support.

Inter-site redundancy for clustering

Inter-site redundancy ensures that a backup owner for a traffic flow will always be at the other
site from the owner. This feature guards against site failure.

New or modified screen: Configuration > Device Management > High Availability and
Scalability > ASA Cluster
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Feature

Description

cluster remove unit command
behavior matches no enable behavior

The cluster remove unit command now removes a unit from the cluster until you manually
reenable clustering or reload, similar to the no enable command. Previously, if you redeployed
the bootstrap configuration from FXOS, clustering would be reenabled. Now, the disabled
status persists even in the case of a bootstrap configuration redeployment. Reloading the ASA,
however, will reenable clustering.

New/Modified screen: Configuration > Device Management > High Availability and
Scalability > ASA Cluster

Administrative, Monitoring, and Troubleshooting Features

SSH version 1 has been deprecated

SSH version 1 has been deprecated, and will be removed in a future release. The default setting
has changed from both SSH v1 and v2 to just SSH v2.

New/Modified screens:

« Configuration > Device Management > Management Access >
ASDM/HTTPS/Telnet/SSH

Enhanced packet tracer and packet
capture capabilities

The packet tracer has been enhanced with the following features:
* Trace a packet when it passes between cluster units.
* Allow simulated packets to egress the ASA.
* Bypass security checks for a similated packet.

* Treat a simulated packet as an [Psec/SSL decrypted packet.

The packet capture has been enhanced with the following features:

* Capture packets after they are decrypted.

* Capture traces and retain them in the persistent list.

New or modified screens:
Tools > Packet Tracer

We added Cluster Capture field to support these options: decrypted, persist, bypass-checks,
transmit

We added two new options in the Filter By view under the All Sessions drop-down list:
Origin and Origin-1D

Monitoring > VPN > VPN Statistics > Packet Tracer and Capture

We added ICMP Capture field in the Packet Capture Wizard screen:Wizards > Packet
Capture Wizard

We added two options include-decrypted and persist to support ICMP Capture.
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Firewall Functional Overview

Firewalls protect inside networks from unauthorized access by users on an outside network. A firewall can
also protect inside networks from each other, for example, by keeping a human resources network separate
from a user network. If you have network resources that need to be available to an outside user, such as a web
or FTP server, you can place these resources on a separate network behind the firewall, called a
demilitarized zone (DMZ). The firewall allows limited access to the DMZ, but because the DMZ only includes
the public servers, an attack there only affects the servers and does not affect the other inside networks. You
can also control when inside users access outside networks (for example, access to the Internet), by allowing
only certain addresses out, by requiring authentication or authorization, or by coordinating with an external
URL filtering server.

When discussing networks connected to a firewall, the outside network is in front of the firewall, the inside
network is protected and behind the firewall, and a DMZ, while behind the firewall, allows limited access to
outside users. Because the ASA lets you configure many interfaces with varied security policies, including
many inside interfaces, many DMZs, and even many outside interfaces if desired, these terms are used in a
general sense only.

Security Policy Overview

A security policy determines which traffic is allowed to pass through the firewall to access another network.
By default, the ASA allows traffic to flow freely from an inside network (higher security level) to an outside
network (lower security level). You can apply actions to traffic to customize the security policy.

Permitting or Denying Traffic with Access Rules

You can apply access rules to limit traffic from inside to outside, or allow traffic from outside to inside. For
bridge group interfaces, you can also apply an EtherType access rule to allow non-IP traffic.

Applying NAT
Some of the benefits of NAT include the following:
* You can use private addresses on your inside networks. Private addresses are not routable on the Internet.
* NAT hides the local addresses from other networks, so attackers cannot learn the real address of a host.

* NAT can resolve IP routing problems by supporting overlapping IP addresses.

Protecting from IP Fragments

The ASA provides IP fragment protection. This feature performs full reassembly of all ICMP error messages
and virtual reassembly of the remaining IP fragments that are routed through the ASA. Fragments that fail
the security check are dropped and logged. Virtual reassembly cannot be disabled.

Applying HTTP, HTTPS, or FTP Filtering

Although you can use access lists to prevent outbound access to specific websites or FTP servers, configuring
and managing web usage this way is not practical because of the size and dynamic nature of the Internet.
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You can configure Cloud Web Security on the ASA, or install an ASA module that provides URL and other
filtering services, such as ASA CX or ASA FirePOWER. You can also use the ASA in conjunction with an
external product such as the Cisco Web Security Appliance (WSA).

Applying Application Inspection

Inspection engines are required for services that embed IP addressing information in the user data packet or
that open secondary channels on dynamically assigned ports. These protocols require the ASA to do a deep
packet inspection.

Sending Traffic to Supported Hardware or Software Modules

Some ASA models allow you to configure software modules, or to insert hardware modules into the chassis,
to provide advanced services. These modules provide additional traffic inspection and can block traffic based
on your configured policies. You can send traffic to these modules to take advantage of these advanced
services.

Applying QoS Policies

Some network traffic, such as voice and streaming video, cannot tolerate long latency times. QoS is a network
feature that lets you give priority to these types of traffic. QoS refers to the capability of a network to provide
better service to selected network traffic.

Applying Connection Limits and TCP Normalization

You can limit TCP and UDP connections and embryonic connections. Limiting the number of connections
and embryonic connections protects you from a DoS attack. The ASA uses the embryonic limit to trigger
TCP Intercept, which protects inside systems from a DoS attack perpetrated by flooding an interface with
TCP SYN packets. An embryonic connection is a connection request that has not finished the necessary
handshake between source and destination.

TCP normalization is a feature consisting of advanced TCP connection settings designed to drop packets that
do not appear normal.

Enabling Threat Detection

You can configure scanning threat detection and basic threat detection, and also how to use statistics to analyze
threats.

Basic threat detection detects activity that might be related to an attack, such as a DoS attack, and automatically
sends a system log message.

A typical scanning attack consists of a host that tests the accessibility of every IP address in a subnet (by
scanning through many hosts in the subnet or sweeping through many ports in a host or subnet). The scanning
threat detection feature determines when a host is performing a scan. Unlike IPS scan detection that is based
on traffic signatures, the ASA scanning threat detection feature maintains an extensive database that contains
host statistics that can be analyzed for scanning activity.

The host database tracks suspicious activity such as connections with no return activity, access of closed
service ports, vulnerable TCP behaviors such as non-random IPID, and many more behaviors.

You can configure the ASA to send system log messages about an attacker or you can automatically shun the
host.
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Firewall Mode Overview

The ASA runs in two different firewall modes:

* Routed

* Transparent

In routed mode, the ASA is considered to be a router hop in the network.

In transparent mode, the ASA acts like a “bump in the wire,” or a “stealth firewall,” and is not considered a
router hop. The ASA connects to the same network on its inside and outside interfaces in a "bridge group".

You might use a transparent firewall to simplify your network configuration. Transparent mode is also useful
if you want the firewall to be invisible to attackers. You can also use a transparent firewall for traffic that
would otherwise be blocked in routed mode. For example, a transparent firewall can allow multicast streams
using an EtherType access list.

Routed mode supports Integrated Routing and Bridging, so you can also configure bridge groups in routed
mode, and route between bridge groups and regular interfaces. In routed mode, you can replicate transparent
mode functionality; if you do not need multiple context mode or clustering, you might consider using routed
mode instead.

Stateful Inspection Overview

All traffic that goes through the ASA is inspected using the Adaptive Security Algorithm and either allowed
through or dropped. A simple packet filter can check for the correct source address, destination address, and
ports, but it does not check that the packet sequence or flags are correct. A filter also checks every packet
against the filter, which can be a slow process.

Note

The TCP state bypass feature allows you to customize the packet flow.

A stateful firewall like the ASA, however, takes into consideration the state of a packet:
* [s this a new connection?

If it is a new connection, the ASA has to check the packet against access lists and perform other tasks to
determine if the packet is allowed or denied. To perform this check, the first packet of the session goes
through the “session management path,” and depending on the type of traffic, it might also pass through
the “control plane path.”

The session management path is responsible for the following tasks:

* Performing the access list checks
* Performing route lookups
* Allocating NAT translations (xlates)

* Establishing sessions in the “fast path”
The ASA creates forward and reverse flows in the fast path for TCP traffic; the ASA also creates

connection state information for connectionless protocols like UDP, ICMP (when you enable ICMP
inspection), so that they can also use the fast path.
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N

Note  For other IP protocols, like SCTP, the ASA does not create reverse path flows.
As aresult, ICMP error packets that refer to these connections are dropped.

Some packets that require Layer 7 inspection (the packet payload must be inspected or altered) are passed
on to the control plane path. Layer 7 inspection engines are required for protocols that have two or more
channels: a data channel, which uses well-known port numbers, and a control channel, which uses different
port numbers for each session. These protocols include FTP, H.323, and SNMP.

* Is this an established connection?

If the connection is already established, the ASA does not need to re-check packets; most matching
packets can go through the “fast” path in both directions. The fast path is responsible for the following
tasks:

* [P checksum verification

* Session lookup

* TCP sequence number check

* NAT translations based on existing sessions

* Layer 3 and Layer 4 header adjustments

Data packets for protocols that require Layer 7 inspection can also go through the fast path.

Some established session packets must continue to go through the session management path or the control
plane path. Packets that go through the session management path include HTTP packets that require
inspection or content filtering. Packets that go through the control plane path include the control packets
for protocols that require Layer 7 inspection.

VPN Functional Overview

A VPN is a secure connection across a TCP/IP network (such as the Internet) that appears as a private
connection. This secure connection is called a tunnel. The ASA uses tunneling protocols to negotiate security
parameters, create and manage tunnels, encapsulate packets, transmit or receive them through the tunnel, and
unencapsulate them. The ASA functions as a bidirectional tunnel endpoint: it can receive plain packets,
encapsulate them, and send them to the other end of the tunnel where they are unencapsulated and sent to
their final destination. It can also receive encapsulated packets, unencapsulate them, and send them to their
final destination. The ASA invokes various standard protocols to accomplish these functions.

The ASA performs the following functions:

» Establishes tunnels

* Negotiates tunnel parameters
* Authenticates users

* Assigns user addresses

* Encrypts and decrypts data
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* Manages security keys
* Manages data transfer across the tunnel

* Manages data transfer inbound and outbound as a tunnel endpoint or router

The ASA invokes various standard protocols to accomplish these functions.

Security Context Overview

You can partition a single ASA into multiple virtual devices, known as security contexts. Each context is an
independent device, with its own security policy, interfaces, and administrators. Multiple contexts are similar
to having multiple standalone devices. Many features are supported in multiple context mode, including
routing tables, firewall features, IPS, and management; however, some features are not supported. See the
feature chapters for more information.

In multiple context mode, the ASA includes a configuration for each context that identifies the security policy,
interfaces, and almost all the options you can configure on a standalone device. The system administrator
adds and manages contexts by configuring them in the system configuration, which, like a single mode
configuration, is the startup configuration. The system configuration identifies basic settings for the ASA.
The system configuration does not include any network interfaces or network settings for itself; rather, when
the system needs to access network resources (such as downloading the contexts from the server), it uses one
of the contexts that is designated as the admin context.

The admin context is just like any other context, except that when a user logs into the admin context, then
that user has system administrator rights and can access the system and all other contexts.

ASA Clustering Overview

ASA Clustering lets you group multiple ASAs together as a single logical device. A cluster provides all the
convenience of a single device (management, integration into a network) while achieving the increased
throughput and redundancy of multiple devices.

You perform all configuration (aside from the bootstrap configuration) on the control unit only; the configuration
is then replicated to the member units.

Special, Deprecated, and Legacy Services

For some services, documentation is located outside of the main configuration guides and online help.
Special Services Guides

Special services allow the ASA to interoperate with other Cisco products; for example, by providing a
security proxy for phone services (Unified Communications), or by providing Botnet traffic filtering in
conjunction with the dynamic database from the Cisco update server, or by providing WCCP services
for the Cisco Web Security Appliance. Some of these special services are covered in separate guides:

 Cisco ASA Botnet Traffic Filter Guide

* Cisco ASA NetFlow Implementation Guide
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* Cisco ASA Unified Communications Guide
* Cisco ASA WCCP Traffic Redirection Guide

* SNMP Version 3 Tools Implementation Guide

Deprecated Services

For deprecated features, see the configuration guide for your ASA version. Similarly, for redesigned
features such as NAT between Version 8.2 and 8.3 or transparent mode interfaces between Version 8.3
and 8.4, refer to the configuration guide for your version. Although ASDM is backwards compatible
with previous ASA releases, the configuration guide and online help only cover the latest release.

Legacy Services Guide

Legacy services are still supported on the ASA, however there may be better alternative services that
you can use instead. Legacy services are covered in a separate guide:

Cisco ASA Legacy Feature Guide

This guide includes the following chapters:
* Configuring RIP
* AAA Rules for Network Access

* Using Protection Tools, which includes Preventing IP Spoofing (ip verify reverse-path), Configuring
the Fragment Size (fragment), Blocking Unwanted Connections (shun), Configuring TCP Options
(for ASDM), and Configuring IP Audit for Basic IPS Support (ip audit).

* Configuring Filtering Services
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CHAPTER 2

Getting Started

This chapter describes how to get started with your Cisco ASA.

* Access the Console for the Command-Line Interface, on page 17
* Configure ASDM Access, on page 27

* Start ASDM, on page 33

* Customize ASDM Operation, on page 34

* Factory Default Configurations, on page 36

* Get Started with the Configuration, on page 49

* Use the Command Line Interface Tool in ASDM, on page 50

* Apply Configuration Changes to Connections, on page 51

Access the Console for the Command-Line Interface

In some cases, you may need to use the CLI to configure basic settings for ASDM access.

For initial configuration, access the CLI directly from the console port. Later, you can configure remote access
using Telnet or SSH according to #unique 38. If your system is already in multiple context mode, then
accessing the console port places you in the system execution space.

N

Note For ASAv console access, see the ASAv quick start guide.

Access the Appliance Console

Follow these steps to access the appliance console.

Procedure

Step 1 Connect a computer to the console port using the provided console cable, and connect to the console using a
terminal emulator set for 9600 baud, 8 data bits, no parity, 1 stop bit, no flow control.

See the hardware guide for your ASA for more information about the console cable.

Step 2 Press the Enter key to see the following prompt:
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ciscoasa>

This prompt indicates that you are in user EXEC mode. Only basic commands are available from user EXEC
mode.

Step 3 Access privileged EXEC mode.
enable

You are prompted for the password. By default, the password is blank, and you can press the Enter key to
continue. See Set the Hostname, Domain Name, and the Enable and Telnet Passwords, on page 593 to change
the enable password.

Example:

ciscoasa> enable
Password:
ciscoasa#

All non-configuration commands are available in privileged EXEC mode. You can also enter configuration
mode from privileged EXEC mode.

To exit privileged mode, enter the disable, exit, or quit command.

Step 4 Access global configuration mode.
configure terminal

Example:

ciscoasa# configure terminal
ciscoasa(config) #

You can begin to configure the ASA from global configuration mode. To exit global configuration mode,
enter the exit, quit, or end command.

Access the Firepower 2100 Console

The Firepower 2100 console port connects you to the FXOS CLI. From the FXOS CLI, you can then connect
to the ASA console, and back again. If you SSH to FXOS, you can also connect to the ASA CLI; a connection
from SSH is not a console connection, so you can have multiple ASA connections from an FXOS SSH
connection. Similarly, if you SSH to the ASA, you can connect to the FXOS CLI.

Before you begin

You can only have one console connection at a time. When you connect to the ASA console from the FXOS
console, this connection is a persistent console connection, not like a Telnet or SSH connection.
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Step 1

Step 2

Step 3

Step 4

Access the Firepower 2100 Console .

Procedure

Connect your management computer to the console port. The Firepower 2100 ships with a DB-9 to RJ-45
serial cable, so you will need a third party serial-to-USB cable to make the connection. Be sure to install any
necessary USB serial drivers for your operating system. Use the following serial settings:

* 9600 baud
* 8 data bits
* No parity

* 1 stop bit

You connect to the FXOS CLI. Enter the user credentials; by default, you can log in with the admin user and
the default password, Admin123.

Connect to the ASA:
connect asa

Example:

firepower-2100# connect asa

Attaching to Diagnostic CLI ... Press 'Ctrl+a then d' to detach.
Type help or '?' for a list of available commands.
ciscoasa>

Access privileged EXEC mode.
enable

You are prompted for the password. By default, the password is blank, and you can press the Enter key to
continue. See Set the Hostname, Domain Name, and the Enable and Telnet Passwords, on page 593 to change
the enable password.

Example:

ciscoasa> enable
Password:
ciscoasa#

All non-configuration commands are available in privileged EXEC mode. You can also enter configuration
mode from privileged EXEC mode.

To exit privileged mode, enter the disable, exit, or quit command.

Access global configuration mode.
configure terminal

Example:

ciscoasa# configure terminal
ciscoasa(config) #
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Step 5
Step 6

You can begin to configure the ASA from global configuration mode. To exit global configuration mode,
enter the exit, quit, or end command.

To return to the FXOS console, enter Ctrl+a, d.
If you SSH to the ASA (after you configure SSH access in the ASA), connect to the FXOS CLI.

connect fxos

You are prompted to authenticate for FXOS; use the default username: admin and password: Admin123. To
return to the ASA CLI, enter exit or type Ctrl-Shift-6, x.

Example:

ciscoasa# connect fxos
Connecting to fxos.
Connected to fxos. Escape character sequence is 'CTRL-"X'.

FXOS 2.2(2.32) kp2110

kp2110 login: admin

Password: Adminl23

Last login: Sat Jan 23 16:20:16 UTC 2017 on pts/1

Successful login attempts for user 'admin' : 4

Cisco Firepower Extensible Operating System (FX-0S) Software

[..]

kp2110#

kp2110# exit

Remote card closed command session. Press any key to continue.
Connection with fxos terminated.

Type help or '?' for a list of available commands.

ciscoasa#

Access the ASA Console on the Firepower 4100/9300 Chassis

Step 1

For initial configuration, access the command-line interface by connecting to the Firepower 4100/9300 chassis
supervisor (either to the console port or remotely using Telnet or SSH) and then connecting to the ASA security
module.

Procedure

Connect to the Firepower 4100/9300 chassis supervisor CLI (console or SSH), and then session to the ASA:
connect module slot console

The first time you access the module, you access the FXOS module CLI. You must then connect to the ASA
application.

connect asa

Example:

Firepower# connect module 1 console
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Step 2

Step 3

Step 4

Step 5

Access the ASA Services Module Console .

Firepower-modulel> connect asa

asa>

Access privileged EXEC mode, which is the highest privilege level.
enable

You are prompted for the password. By default, the password is blank, and you can press the Enter key to
continue. See Set the Hostname, Domain Name, and the Enable and Telnet Passwords, on page 593 to change
the enable password.

Example:

asa> enable
Password:
asa#

All non-configuration commands are available in privileged EXEC mode. You can also enter configuration
mode from privileged EXEC mode.

To exit privileged mode, enter the disable, exit, or quit command.
Enter global configuration mode.

configure terminal

Example:

asa# configure terminal
asa (config) #

To exit global configuration mode, enter the disable, exit, or quit command.

Exit the application console to the FXOS module CLI by entering Ctrl-a, d
You might want to use the FXOS module CLI for troubleshooting purposes.
Return to the supervisor level of the FXOS CLI.
a) Enter ~

You exit to the Telnet application.
b) To exit the Telnet application, enter:

telnet>quit

Access the ASA Services Module Console

For initial configuration, access the command-line interface by connecting to the switch (either to the console
port or remotely using Telnet or SSH) and then connecting to the ASASM. The ASASM does not include a
factory default configuration, so you must perform some configuration at the CLI before you can access it
using ASDM. This section describes how to access the ASASM CLI.
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About Connection Methods

From the switch CLI, you can use two methods to connect to the ASASM:

» Virtual console connection—Using the service-module session command, you create a virtual console
connection to the ASASM, with all the benefits and limitations of an actual console connection.

Benefits include:

* The connection is persistent across reloads and does not time out.
* You can stay connected through ASASM reloads and view startup messages.
* You can access ROMMON if the ASASM cannot load the image.

* No initial password configuration is required.

Limitations include:

* The connection is slow (9600 baud).
* You can only have one console connection active at a time.

* You cannot use this command in conjunction with a terminal server where Ctrl-Shift-6, X is the
escape sequence to return to the terminal server prompt. Ctrl-Shift-6, X is also the sequence to
escape the ASASM console and return to the switch prompt. Therefore, if you try to exit the ASASM
console in this situation, you instead exit all the way to the terminal server prompt. If you reconnect
the terminal server to the switch, the ASASM console session is still active; you can never exit to
the switch prompt. You must use a direct serial connection to return the console to the switch prompt.
In this case, either change the terminal server or switch escape character in Cisco I0S software, or
use the Telnet session command instead.

A

Note Because of the persistence of the console connection, if you do not properly log
out of the ASASM, the connection may exist longer than intended. If someone
else wants to log in, they will need to kill the existing connection.

* Telnet connection—Using the session command, you create a Telnet connection to the ASASM.

N

Note  You cannot connect using this method for a new ASASM; this method requires
you to configure a Telnet login password on the ASASM (there is no default
password). After you set a password using the passwd command, you can use
this method.

Benefits include:

* You can have multiple sessions to the ASASM at the same time.

e The Telnet session is a fast connection.

Limitations include:

¢ The Telnet session is terminated when the ASASM reloads, and can time out.
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Log Into the ASA Services Module .

* You cannot access the ASASM until it completely loads; you cannot access ROMMON.

* You must first set a Telnet login password; there is no default password.

Log Into the ASA Services Module

For initial configuration, access the command-line interface by connecting to the switch (either to the switch
console port or remotely using Telnet or SSH) and then connecting to the ASASM.

Step 1

If your system is already in multiple context mode, then accessing the ASASM from the switch places you
in the system execution space.

Later, you can configure remote access directly to the ASASM using Telnet or SSH.

Procedure

From the switch, perform one of the following:

Available for initial access—From the switch CLI, enter this command to gain console access to the
ASASM:

service-module session [switch {1|2}] slot number

Example:

Router# service-module session slot 3

ciscoasa>

For a switch in a VSS, enter the switch argument.

To view the module slot numbers, enter the show module command at the switch prompt.

You access user EXEC mode.

Available after you configure a login password—From the switch CLI, enter this command to Telnet to
the ASASM over the backplane:

session [switch {1 || 2}] slot number processor 1

You are prompted for the login password:
ciscoasa passwd:
Example:

Router# session slot 3 processor 1
ciscoasa passwd: cisco
ciscoasa>

For a switch in a VSS, enter the switch argument.

The session slot processor 0 command, which is supported on other services modules, is not supported
on the ASASM; the ASASM does not have a processor 0.

To view the module slot numbers, enter the show module command at the switch prompt.
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Step 2

Step 3

Enter the login password to the ASASM. Set the password using the passwd command. There is no
default password.

You access user EXEC mode.

Access privileged EXEC mode, which is the highest privilege level.
enable

You are prompted for the password. By default, the password is blank, and you can press the Enter key to
continue. See Set the Hostname, Domain Name, and the Enable and Telnet Passwords, on page 593 to change
the enable password.

Example:

ciscoasa> enable
Password:
ciscoasa#

All non-configuration commands are available in privileged EXEC mode. You can also enter configuration
mode from privileged EXEC mode.

To exit privileged mode, enter the disable, exit, or quit command.

Access global configuration mode:
configure terminal

To exit global configuration mode, enter the disable, exit, or quit command.

Related Topics
Guidelines for Management Access
Set the Hostname, Domain Name, and the Enable and Telnet Passwords, on page 593

Log Out of a Console Session

If you do not log out of the ASASM, the console connection persists; there is no timeout. To end the ASASM
console session and access the switch CLI, perform the following steps.

To kill another user’s active connection, which may have been unintentionally left open, see Kill an Active
Console Connection, on page 25.

Procedure

To return to the switch CLI, type the following:
Ctrl-Shift-6, x

You return to the switch prompt:

asasm# [Ctrl-Shift-6, x]
Router#
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Note Shift-6 on US and UK keyboards issues the caret (*) character. If you have a different keyboard
and cannot issue the caret (") character as a standalone character, you can temporarily or permanently
change the escape character to a different character. Use the terminal escape-character ascii_number
command (to change for this session) or the default escape-character ascii_number command (to
change permanently). For example, to change the sequence for the current session to Ctrl-w, X,
enter terminal escape-character 23.

Kill an Active Console Connection

Because of the persistence of a console connection, if you do not properly log out of the ASASM, the connection
may exist longer than intended. If someone else wants to log in, they will need to kill the existing connection.

Procedure

Step 1 From the switch CLI, show the connected users using the show users command. A console user is called
“con”. The Host address shown is 127.0.0.90t0, where sot is the slot number of the module.

show users

For example, the following command output shows a user “con” on line 0 on a module in slot 2:

Router# show users

Line User Host (s) Idle Location
* 0 con 0 127.0.0.20 00:00:02
Step 2 To clear the line with the console connection, enter the following command:

clear line number

For example:

Router# clear line 0

Log Out of a Telnet Session

To end the Telnet session and access the switch CLI, perform the following steps.

Procedure

To return to the switch CLI, type exit from the ASASM privileged or user EXEC mode. If you are in a
configuration mode, enter exit repeatedly until you exit the Telnet session.

You return to the switch prompt:

asasm# exit
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Router#

Note You can alternatively escape the Telnet session using the escape sequence Ctrl-Shift-6, x; this
escape sequence lets you resume the Telnet session by pressing the Enter key at the switch prompt.
To disconnect your Telnet session from the switch, enter disconnect at the switch CLIL. If you do
not disconnect the session, it will eventually time out according to the ASASM configuration.

Access the Software Module Console

)

If you have a software module installed, such as the ASA FirePOWER module on the ASA 5506-X, you can
session to the module console.

Note

You cannot access the hardware module CLI over the ASA backplane using the session command.

Procedure

From the ASA CLI, session to the module:
session {sfr | cxsc | ips} console

Example:

ciscoasa# session sfr console
Opening console session with module sfr.
Connected to module sfr. Escape character sequence is 'CTRL-"X'.

Cisco ASA SFR Boot Image 5.3.1
asasfr login: admin
Password: Adminl23

Access the ASA 5506W-X Wireless Access Point Console

Step 1

To access the wireless access point console, perform the following steps.

Procedure

From the ASA CLI, session to the access point:
session wlan console

Example:

ciscoasa# session wlan console
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opening console session with module wlan
connected to module wlan. Escape character sequence is ‘CTRL-"X’

ap>

Step 2 See the Cisco I0S Configuration Guide for Autonomous Aironet Access Points for information about the
access point CLI.

Configure ASDM Access

This section describes how to access ASDM with a default configuration and how to configure access if you
do not have a default configuration.

Use the Factory Default Configuration for ASDM Access (Appliances, ASAv)

With a factory default configuration, ASDM connectivity is pre-configured with default network settings.

Procedure

Connect to ASDM using the following interface and network settings:
» The management interface depends on your model:

* Firepower 2100—Management 1/1 (192.168.45.1). Management hosts are limited to the
192.168.45.0/24 network.

* Firepower 4100/9300—The Management type interface and IP address of your choice defined when
you deployed. Management hosts are allowed from any network.

* ASA 5506-X, ASA 5506W-X—Inside GigabitEthernet 1/2 through 1/8, and wifi GigabitEthernet
1/9 (192.168.10.1). Inside hosts are limited to the 192.168.1.0/24 network, and wifi hosts are limited
to 192.168.10.0/24.

* ASA 5508-X, and ASA 5516-X—Inside GigabitEthernet 1/2 (192.168.1.1). Inside hosts are limited
to the 192.168.1.0/24 network.

* ASA 5512-X and higher—Management 0/0 (192.168.1.1). Management hosts are limited to the
192.168.1.0/24 network.

* ASAv—Management 0/0 (set during deployment). Management hosts are limited to the management
network.

* ISA 3000—Management 1/1 (192.168.1.1). Management hosts are limited to the 192.168.1.0/24
network.

Note If you change to multiple context mode, you can access ASDM from the admin context using the
network settings above.
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Related Topics
Factory Default Configurations, on page 36
Enable or Disable Multiple Context Mode, on page 251
Start ASDM, on page 33

Customize ASDM Access

)

This procedure applies to all models except the ASA Services Module.
Use this procedure if one or more of the following conditions applies:
* You do not have a factory default configuration
* You want to change to transparent firewall mode
* You want to change to multiple context mode
For routed, single mode, for quick and easy ASDM access, we recommend applying the factory default
configuration with the option to set your own management IP address. Use the procedure in this section only

if you have special needs such as setting transparent or multiple context mode, or if you have other configuration
that you need to preserve.

Note

Step 1
Step 2

Step 3

For the ASAv, you can configure transparent mode when you deploy, so this procedure is primarily useful
after you deploy if you need to clear your configuration, for example.

Procedure

Access the CLI at the console port.

(Optional) Enable transparent firewall mode:
This command clears your configuration.

firewall transparent

Configure the management interface:

interface interface id
nameif name
security-level level
no shutdown
ip address ip address mask

Example:

ciscoasa(config)# interface management 0/0
ciscoasa(config-if) # nameif management
ciscoasa(config-if)# security-level 100
ciscoasa(config-if)# no shutdown

ciscoasa(config-if)# ip address 192.168.1.1 255.255.255.0
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The security-level is a number between 1 and 100, where 100 is the most secure.

Step 4 (For directly-connected management hosts) Set the DHCP pool for the management network:

dhcpd address ip address-ip address interface name
dhcpd enable interface name

Example:

ciscoasa(config) # dhcpd address 192.168.1.2-192.168.1.254 management
ciscoasa(config) # dhcpd enable management

Make sure you do not include the interface address in the range.
Step 5 (For remote management hosts) Configure a route to the management hosts:
route management_ifc management_host_ip mask gateway ip 1

Example:

ciscoasa(config)# route management 10.1.1.0 255.255.255.0 192.168.1.50 1

Step 6 Enable the HTTP server for ASDM:
http server enable

Step 7 Allow the management host(s) to access ASDM:
http ip_address mask interface_name

Example:

ciscoasa(config)# http 192.168.1.0 255.255.255.0 management

Step 8 Save the configuration:

write memory
Step 9 (Optional) Set the mode to multiple mode:

mode multiple

When prompted, confirm that you want to convert the existing configuration to be the admin context. You
are then prompted to reload the ASA.

Examples

The following configuration converts the firewall mode to transparent mode, configures the
Management 0/0 interface, and enables ASDM for a management host:

firewall transparent
interface management 0/0
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ip address 192.168.1.1 255.255.255.0
nameif management

security-level 100

no shutdown

dhcpd address 192.168.1.2-192.168.1.254 management
dhcpd enable management

http server enable

http 192.168.1.0 255.255.255.0 management

Related Topics
Restore the Factory Default Configuration, on page 37
Set the Firewall Mode (Single Mode), on page 213
Access the Appliance Console, on page 17
Start ASDM, on page 33

Configure ASDM Access for the ASA Services Module

Step 1
Step 2

Step 3

Because the ASASM does not have physical interfaces, it does not come pre-configured for ASDM access;
you must configure ASDM access using the CLI on the ASASM. To configure the ASASM for ASDM access,
perform the following steps.

Before you begin
Assign a VLAN interface to the ASASM according to ASASM quick start guide.

Procedure

Connect to the ASASM and access global configuration mode.

(Optional) Enable transparent firewall mode:
firewall transparent

This command clears your configuration.

Do one of the following to configure a management interface, depending on your mode:

* Routed mode—Configure an interface in routed mode:

interface vlan number
ip address ip address [mask]
nameif name
security-level level

Example:

ciscoasa(config) # interface vlan 1

ciscoasa(config-if)# ip address 192.168.1.1 255.255.255.0
ciscoasa(config-if)# nameif inside

ciscoasa (config-if)# security-level 100

The security-level is a number between 1 and 100, where 100 is the most secure.
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Step 4

Step 5

Step 6

Step 7

Configure ASDM Access for the ASA Services Module .

* Transparent mode—Configure a bridge virtual interface and assigns a management VLAN to the bridge
group:

interface bvi number
ip address ip address [mask]

interface vlan number
bridge-group bvi number
nameif name
security-level level

Example:

ciscoasa(config)# interface bvi 1
ciscoasa(config-if)# ip address 192.168.1.1 255.255.255.0

ciscoasa
ciscoasa
ciscoasa
ciscoasa

config) # interface vlan 1
config-if)# bridge-group 1
config-if) # nameif inside
config-if)# security-level 100

The security-level is a number between 1 and 100, where 100 is the most secure.

(For directly-connected management hosts) Enable DHCP for the management host on the management
interface network:

dhcpd address ip address-ip address interface name
dhcpd enable interface name

Example:

ciscoasa(config) # dhcpd address 192.168.1.2-192.168.1.254 inside
ciscoasa (config)# dhcpd enable inside

Make sure you do not include the management address in the range.

(For remote management hosts) Configure a route to the management hosts:
route management_ifc management_host_ip mask gateway ip 1

Example:

ciscoasa(config) # route management 10.1.1.0 255.255.255.0 192.168.1.50

Enable the HTTP server for ASDM:

http server enable

Allow the management host to access ASDM:
http ip_address mask interface_name

Example:
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ciscoasa(config)# http 192.168.1.0 255.255.255.0 management

Step 8 Save the configuration:

write memory

Step 9 (Optional) Set the mode to multiple mode:
mode multiple

When prompted, confirm that you want to convert the existing configuration to be the admin context. You
are then prompted to reload the ASASM.

Examples

The following routed mode configuration configures the VLAN 1 interface and enables ASDM for
a management host:

interface vlan 1

nameif inside

ip address 192.168.1.1 255.255.255.0
security-level 100

dhcpd address 192.168.1.3-192.168.1.254 inside
dhcpd enable inside

http server enable

http 192.168.1.0 255.255.255.0 inside

The following configuration converts the firewall mode to transparent mode, configures the VLAN
1 interface and assigns it to BVI 1, and enables ASDM for a management host:

firewall transparent
interface bvi 1

ip address 192.168.1.1 255.255.255.0
interface vlan 1

bridge-group 1

nameif inside

security-level 100

dhcpd address 192.168.1.3-192.168.1.254 inside
dhcpd enable inside

http server enable

http 192.168.1.0 255.255.255.0 inside

Related Topics
Access the ASA Services Module Console, on page 21
About Connection Methods, on page 22
Log Out of a Console Session, on page 24
Kill an Active Console Connection, on page 25
Log Out of a Telnet Session, on page 25
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Set the Firewall Mode (Single Mode), on page 213

Start ASDM

\}

You can start ASDM using two methods:

* ASDM-IDM Launcher—The Launcher is an application downloaded from the ASA using a web browser
that you can use to connect to any ASA IP address. You do not need to re-download the launcher if you
want to connect to other ASAs.

+ Java Web Start—For each ASA that you manage, you need to connect with a web browser and then save
or launch the Java Web Start application. You can optionally save the shortcut to your computer; however
you need separate shortcuts for each ASA IP address.

Note

Step 1

Step 2

If you use web start, clear the Java cache or you might lose changes to some pre-login policies such as Hostscan.
This problem does not occur if you use the launcher.

Within ASDM, you can choose a different ASA IP address to manage; the difference between the Launcher
and Java Web Start functionality rests primarily in how you initially connect to the ASA and launch ASDM.

This section describes how to connect to ASDM initially, and then launch ASDM using the Launcher or the
Java Web Start.

ASDM stores files in the local \Users\<user id>\.asdm directory, including cache, log, and preferences, and
also in the Temp directory, including AnyConnect profiles.

Procedure

On the computer that you specified as the ASDM client, enter the following URL:
https://asa_ip_address/admin
Note Be sure to specify https://, and not http:// or just the IP address (which defaults to HTTP); the ASA
does not automatically forward an HTTP request to HTTPS.
The ASDM launch page appears with the following buttons:
* Install ASDM Launcher and Run ASDM

* Run ASDM

* Run Startup Wizard

To download the Launcher:

a) Click Install ASDM Launcher and Run ASDM.

b) Leave the username and password fields empty (for a new installation), and click OK. With no HTTPS
authentication configured, you can gain access to ASDM with no username and the enable password,
which is blank by default. Note: If you enabled HTTPS authentication, enter your username and associated
password. Even without authentication, if you enter a username and password at the login screen (instead
of leaving the username blank), ASDM checks the local database for a match.
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Step 3

¢) Save the installer to your computer, and then start the installer. The ASDM-IDM Launcher opens
automatically after installation is complete.

d) Enter the management IP address, the same username and password (blank for a new installation), and
then click OK.

To use Java Web Start:

a) Click Run ASDM or Run Startup Wizard.

b) Save the shortcut to your computer when prompted. You can optionally open it instead of saving it.

c) Start Java Web Start from the shortcut.

d) Accept any certificates according to the dialog boxes that appear. The Cisco ASDM-IDM Launcher
appears.

e) Leave the username and password fields empty (for a new installation), and click OK. With no HTTPS
authentication configured, you can gain access to ASDM with no username and the enable password,
which is blank by default. Note: If you enabled HTTPS authentication, enter your username and associated
password. Even without authentication, if you enter a username and password at the login screen (instead
of leaving the username blank), ASDM checks the local database for a match.

Customize ASDM Operation

You can install an identity certificate to successfully launch ASDM as well as increase the ASDM heap
memory so it can handle larger configurations.

Install an Identity Certificate for ASDM

When using Java 7 update 51 and later, the ASDM Launcher requires a trusted certificate. An easy approach
to fulfill the certificate requirements is to install a self-signed identity certificate. You can use Java Web Start
to launch ASDM until you install a certificate.

See the following document to install a self-signed identity certificate on the ASA for use with ASDM, and
to register the certificate with Java.

http://www.cisco.com/go/asdm-certificate

Increase the ASDM Configuration Memory

ASDM supports a maximum configuration size of 512 KB. If you exceed this amount you may experience
performance issues. For example, when you load the configuration, the status dialog box shows the percentage
of the configuration that is complete, yet with large configurations it stops incrementing and appears to suspend
operation, even though ASDM might still be processing the configuration. If this situation occurs, we
recommend that you consider increasing the ASDM system heap memory.

Increase the ASDM Configuration Memory in Windows

To increase the ASDM heap memory size, edit the run.bat file by performing the following procedure.
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Procedure

Step 1 Go to the ASDM installation directory, for example C:\Program Files (x86)\Cisco Systems\ASDM.
Step 2 Edit the run.bat file with any text editor.

Step 3 In the line that starts with “start javaw.exe”, change the argument prefixed with “-Xmx" to specify your desired
heap size. For example, change it to -Xmx768M for 768 MB or -Xmx1G for 1 GB.

Step 4 Save the run.bat file.

Increase the ASDM Configuration Memory in Mac 0S

To increase the ASDM heap memory size, edit the Info.plist file by performing the following procedure.

Procedure

Step 1 Right-click the Cisco ASDM-IDM icon, and choose Show Package Contents.

Step 2 In the Contents folder, double-click the Info.plist file. If you have Developer tools installed, it opens in the
Property List Editor. Otherwise, it opens in TextEdit.

Step 3 Under Java > VMOptions, change the string prefixed with “-Xmx” to specify your desired heap size. For
example, change it to -Xmx768M for 768 MB or -Xmx1G for 1 GB.

<key>CFBundleIconFile</key:>
<stringrasdm3Z.jicng</string:-

<key>VMOptions</lkey:>
<string>-EmsHdm -Xmxz5 12m|</string>

<key>CFBundleDocumentTypes</key>
<arrayx

Step 4 If this file is locked, you see an error such as the following:

The file “Info.plist” is locked because you
haven't made any changes to it recently.

,;' If you want to make changes to this document, click
Unlock. To keep the file unchanged and work with a copy,
click Duplicate.

Unlock Cancel [ Duplicate |

TaE4

Step 5 Click Unlock and save the file.
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If you do not see the Unlock dialog box, exit the editor, right-click the Cisco ASDM-IDM icon, choose Copy
Cisco ASDM-IDM, and paste it to a location where you have write permissions, such as the Desktop. Then
change the heap size from this copy.

Factory Default Configurations

The factory default configuration is the configuration applied by Cisco to new ASAs.

ASA 5506-X—The factory default configuration enables a functional inside/outside configuration. You
can manage the ASA using ASDM from the inside interfaces, which are placed in a bridge group using
Integrated Routing and Bridging.

ASA 5508-X and 5516-X—The factory default configuration enables a functional inside/outside
configuration. You can manage the ASA using ASDM from the inside interface.

ASA 5512-X through ASA 5585-X—The factory default configuration configures an interface for
management so that you can connect to it using ASDM, with which you can then complete your
configuration.

Firepower 2100—The factory default configuration enables a functional inside/outside configuration.
You can manage the ASA using the Firepower Chassis Manager and ASDM from the management
interface.

Firepower 4100/9300 chassis—When you deploy the standalone or cluster of ASAs, the factory default
configuration configures an interface for management so that you can connect to it using ASDM, with
which you can then complete your configuration.

ASAv—Depending on your hypervisor, as part of deployment, the deployment configuration (the initial
virtual deployment settings) configures an interface for management so that you can connect to it using
ASDM, with which you can then complete your configuration. You can also configure failover IP
addresses. You can also apply a “factory default” configuration if desired.

ASASM—No default configuration. See Access the ASA Services Module Console, on page 21 to start
configuration.

ISA 3000—The factory default configuration is an almost-complete transparent firewall mode
configuration with all inside and outside interfaces on the same network; you can connect to the
management interface with ASDM to set the IP address of your network. Hardware bypass is enabled
for two interface pairs, and all traffic is sent to the ASA FirePOWER module in Inline Tap Monitor-Only
Mode. This mode sends a duplicate stream of traffic to the ASA Firepower module for monitoring
purposes only.

For appliances and the Firepower 4100/9300 chassis, the factory default configuration is available only for
routed firewall mode and single context mode, except for the ISA 3000, where the factory default configuration
is only available in transparent mode. For the ASAv, you can choose transparent or routed mode at deployment.
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Restore the Factory Default Configuration .

Note

In addition to the image files and the (hidden) default configuration, the following folders and files are standard
in flash memory: log/, crypto_archive/, and coredumpinfo/coredump.cfg. The date on these files may not
match the date of the image files in flash memory. These files aid in potential troubleshooting; they do not
indicate that a failure has occurred.

Restore the Factory Default Configuration

\)

This section describes how to restore the factory default configuration. Both CLI and ASDM procedures are
provided. For the ASAwv, this procedure erases the deployment configuration and applies the same factory
default configuration as for the ASA 5525-X.

Note

Step 1

On the ASASM, restoring the factory default configuration simply erases the configuration; there is no factory
default configuration.

On the Firepower 4100/9300, restoring the factory default configuration simply erases the configuration; to
restore the default configuration, you must re-deploy the ASA from the supervisor.

Before you begin

This feature is available only in routed firewall mode, except for the ISA 3000, where this command is only
supported in transparent mode. In addition, this feature is available only in single context mode; an ASA with
a cleared configuration does not have any defined contexts to configure automatically using this feature.

Procedure

Restore the factory default configuration:
configure factory-default [ip_address [mask]]

Example:

ciscoasa (config)# configure factory-default 10.1.1.1 255.255.255.0

If you specify the ip_address, then you set the inside or management interface IP address, depending on your
model, instead of using the default IP address. See the following model guidelines for which interface is set
by the ip_address option:

* Firepower 2100—Sets the management interface IP address.

* Firepower 4100/9300—No effect.

» ASAv—Sets the management interface IP address.

* ASA 5506-X—Sets the inside interface IP address.

* ASA 5508-X and 5516-X—Sets the inside interface IP address.

* ASA 5512-X, 5515-X, 5525-X, 5545-X, 5555-X—Sets the management interface IP address.
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Step 2

Step 3

* ASA 5585-X—Sets the management interface IP address.
* ISA 3000—Sets the management interface IP address.

* ASASM—No effect.

The http command uses the subnet you specify. Similarly, the dhcpd address command range consists of
all available addresses higher than the IP address you specify. For example, if you specify 10.5.6.78 with a
subnet mask of 255.255.255.0, then the DHCP address range will be 10.5.6.79-10.5.6.254.

For the Firepower 2100: This model does not use the boot system command; packages are managed by FXOS.

For all other models: This command clears the boot system command, if present, along with the rest of the
configuration. The boot system command lets you boot from a specific image. The next time you reload the
ASA after restoring the factory configuration, it boots from the first image in internal flash memorys; if you
do not have an image in internal flash memory, the ASA does not boot.

Example:

docs-bxb-asa3 (config)# configure factory-default 10.86.203.151 255.255.254.0
Based on the management IP address and mask, the DHCP address
pool size is reduced to 103 from the platform limit 256

WARNING: The boot system configuration will be cleared.

The first image found in diskO:/ will be used to boot the
system on the next reload.

Verify there is a valid image on disk0:/ or the system will
not boot.

Begin to apply factory-default configuration:

Clear all configuration

WARNING: The new maximum-session limit will take effect after the running-config is saved
and the system boots next time. Command accepted

WARNING: Local user database is empty and there are still 'aaa' commands for 'LOCAL'.
Executing command: interface management0/0

Executing command: nameif management

INFO: Security level for "management" set to 0 by default.

Executing command: ip address 10.86.203.151 255.255.254.0

Executing command: security-level 100

Executing command: no shutdown

Executing command: exit

Executing command: http server enable

Executing command: http 10.86.202.0 255.255.254.0 management

Executing command: dhcpd address 10.86.203.152-10.86.203.254 management

Executing command: dhcpd enable management

Executing command: logging asdm informational

Factory-default configuration is completed

ciscoasa(config) #

Save the default configuration to flash memory:
write memory

This command saves the running configuration to the default location for the startup configuration, even if
you previously configured the boot config command to set a different location; when the configuration was
cleared, this path was also cleared.

(ASDM procedure.) In the main ASDM application window, do the following:
a) Choose File > Reset Device to the Factory Default Configuration.

The Reset Device to the Default Configuration dialog box appears.
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Restore the ASAv Deployment Configuration .

b) (Optional) Enter the Management IP address of the management or inside interface, instead of using
the default address.

See the previous CLI step for details about which interface IP is set per model.

¢) (Optional) Choose the Management Subnet Mask from the drop-down list.
d) Click OK.

A confirmation dialog box appears.

Note For the Firepower 2100: This model does not use the boot image location; packages are managed
by FXOS.

For all other models: This action also clears the location of the boot image, if present, along
with the rest of the configuration. The Configuration > Device Management > System
Image/Configuration > Boot Image/Configuration pane lets you boot from a specific image,
including an image on the external memory. The next time you reload the ASA after restoring
the factory configuration, it boots from the first image in internal flash memory; if you do not
have an image in internal flash memory, the ASA does not boot.

e) Click Yes.

f) After you restore the default configuration, save this configuration to internal flash memory. Choose File
> Save Running Configuration to Flash.

Choosing this option saves the running configuration to the default location for the startup configuration,
even if you have previously configured a different location. When the configuration was cleared, this path
was also cleared.

Restore the ASAv Deployment Configuration

Step 1

Step 2

Step 3

This section describes how to restore the ASAv deployment (Day 0) configuration.

Procedure

For failover, power off the standby unit.

To prevent the standby unit from becoming active, you must power it off. If you leave it on, when you erase
the active unit configuration, then the standby unit becomes active. When the former active unit reloads and
reconnects over the failover link, the old configuration will sync from the new active unit, wiping out the
deployment configuration you wanted.

Restore the deployment configuration after you reload. For failover, enter this command on the active unit:
write erase

Note The ASAv boots the current running image, so you are not reverted to the original boot image. To
use the original boot image, see the boot image command.

Do not save the configuration.

Reload the ASAv and load the deployment configuration:
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reload

Step 4 For failover, power on the standby unit.

After the active unit reloads, power on the standby unit. The deployment configuration will sync to the standby
unit.

ASA 5506-X Series Default Configuration

The default factory configuration for the ASA 5506-X series configures the following:

* Integrated Routing and Bridging functionality—GigabitEthernet 1/2 through 1/8 belong to bridge group
1; Bridge Virtual Interface (BVI) 1

* inside --> outside traffic flow—GigabitEthernet 1/1 (outside), BVI 1 (inside)

* outside IP address from DHCP, inside IP address—192.168.1.1

* (ASA 5506W-X) wifi <--> inside, wifi --> outside traffic flow—GigabitEthernet 1/9 (wifi)
* (ASA 5506W-X) wifi IP address—192.168.10.1

* DHCP for clients on inside and wifi. The access point itself and all its clients use the ASA as the DHCP
server.

» Management 1/1 interface is Up, but otherwise unconfigured. The ASA FirePOWER module can then
use this interface to access the ASA inside network and use the inside interface as the gateway to the
Internet.

* ASDM access—inside and wifi hosts allowed.

* NAT—Interface PAT for all traffic from inside, wifi, and management to outside.

The configuration consists of the following commands:

interface Managementl/1
management-only
no nameif
no security-level
no ip address
no shutdown

interface GigabitEthernetl/1
nameif outside
security-level O
ip address dhcp setroute
no shutdown

|

interface GigabitEthernetl/2
nameif inside 1
security-level 100
bridge-group 1
no shutdown

interface GigabitEthernetl/3
nameif inside 2
security-level 100
no shutdown
bridge-group 1
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interface GigabitEthernetl/4

nameif inside 3

security-level 100

no shutdown

bridge-group 1
interface GigabitEthernetl/5

nameif inside 4

security-level 100

no shutdown

bridge-group 1
interface GigabitEthernetl/6

nameif inside 5

security-level 100

no shutdown

bridge-group 1
interface GigabitEthernetl/7

nameif inside 6

security-level 100

no shutdown

bridge-group 1
interface GigabitEthernetl/8

nameif inside 7

security-level 100

no shutdown

bridge-group 1
|
interface bvi 1

nameif inside

security-level 100

ip address 192.168.1.1 255.255.255.0
|
object network obj anyl

subnet 0.0.0.0 0.0.0.0

nat (inside_1,outside) dynamic interface
object network obj any2

subnet 0.0.0.0 0.0.0.0

nat (inside_2,outside) dynamic interface
object network obj any3

subnet 0.0.0.0 0.0.0.0

nat (inside_3,outside) dynamic interface
object network obj any4

subnet 0.0.0.0 0.0.0.0

nat (inside_4,outside) dynamic interface
object network obj any5

subnet 0.0.0.0 0.0.0.0

nat (inside_5,outside) dynamic interface
object network obj any6

subnet 0.0.0.0 0.0.0.0

nat (inside_ 6,outside) dynamic interface
object network obj any7

subnet 0.0.0.0 0.0.0.0

nat (inside_7,outside) dynamic interface
|
same-security-traffic permit inter-interface
|

http server enable

http 192.168.1.0 255.255.255.0 inside 1
http 192.168.1.0 255.255.255.0 inside 2
http 192.168.1.0 255.255.255.0 inside 3
http 192.168.1.0 255.255.255.0 inside 4
http 192.168.1.0 255.255.255.0 inside 5
http 192.168.1.0 255.255.255.0 inside 6

1.0 255.255.255.0 inside 7

http 192.168.
I
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dhcpd auto_config outside

dhcpd address 192.168.1.5-192.168.1.254 inside
dhcpd enable inside

|

logging asdm informational

For the ASA 5506W-X, the following commands are also included:

interface GigabitEthernet 1/9
security-level 100
nameif wifi
ip address 192.168.10.1 255.255.255.0

no shutdown

|

object network obj any wifi
subnet 0.0.0.0 0.0.0.0

nat (wifi,outside) dynamic interface
|

http 192.168.10.0 255.255.255.0 wifi
|

dhcpd address 192.168.10.2-192.168.10.254 wifi
dhcpd enable wifi

ASA 5508-X and 5516-X Default Configuration

The default factory configuration for the ASA 5508-X and 5516-X configures the following:
* inside --> outside traffic flow—GigabitEthernet 1/1 (outside), GigabitEthernet 1/2 (inside)
« outside IP address from DHCP
« inside IP address—192.168.1.1
* DHCP server on inside.
* Default route from outside DHCP

» Management 1/1 interface is Up, but otherwise unconfigured. The ASA FirePOWER module can then
use this interface to access the ASA inside network and use the inside interface as the gateway to the
Internet.

* ASDM access—inside hosts allowed.

* NAT—Interface PAT for all traffic from inside and management to outside.

The configuration consists of the following commands:

interface Managementl/1
management-only
no nameif
no security-level
no ip address
no shutdown

interface GigabitEthernetl/1
nameif outside
security-level 0
ip address dhcp setroute
no shutdown
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interface GigabitEthernetl/2
nameif inside
security-level 100
ip address 192.168.1.1 255.255.255.0
no shutdown
|
object network obj any
subnet 0.0.0.0 0.0.0.0
nat (any,outside) dynamic interface
|
http server enable
http 192.168.1.0 255.255.255.0 inside
|

dhcpd auto_config outside

dhcpd address 192.168.1.5-192.168.1.254 inside
dhcpd enable inside

|

logging asdm informational

ASA 5512-X through ASA 5585-X Default Configuration

The default factory configuration for the ASA 5512-X through ASA 5585-X configures the following:
» Management interface—Management 0/0 (management).
* [P address—The management address is 192.168.1.1/24.

* DHCP server—Enabled for management hosts so that a computer connecting to the management interface
receives an address between 192.168.1.2 and 192.168.1.254.

» ASDM access—Management hosts allowed.

The configuration consists of the following commands:

interface management 0/0
ip address 192.168.1.1 255.255.255.0
nameif management
security-level 100
no shutdown
|
asdm logging informational
asdm history enable
|
http server enable
http 192.168.1.0 255.255.255.0 management
|
dhcpd address 192.168.1.2-192.168.1.254 management
dhcpd enable management

Firepower 2100 Default Configuration

ASA Configuration
The default factory configuration for the ASA on the Firepower 2100 configures the following:

« inside—outside traffic flow—Ethernet 1/1 (outside), Ethernet 1/2 (inside)

ASDM Book 1: Cisco ASA Series General Operations ASDM Configuration Guide, 7.9 [JJj



Getting Started with the ASA |
. Firepower 2100 Default Configuration

« outside IP address from DHCP, inside IP address—192.168.1.1

* DHCP server on inside interface

+ Default route from outside DHCP

* management—Management 1/1 (management), IP address 192.168.45.1
* ASDM access—Management hosts allowed.

* NAT—Interface PAT for all traffic from inside to outside.

» FXOS management traffic initiation—The FXOS chassis can initiate management traffic on the ASA
outside interface.

* DNS servers—OpenDNS servers are pre-configured.
The configuration consists of the following commands:

interface Managementl/1
management-only
nameif management
security-level 100
ip address 192.168.45.1 255.255.255.0
no shutdown
|
interface Ethernetl/1
nameif outside
security-level 0
ip address dhcp setroute
no shutdown
|
interface Ethernetl/2
nameif inside
security-level 100
ip address 192.168.1.1 255.255.255.0
no shutdown
|
object network obj any
subnet 0.0.0.0 0.0.0.0
nat (any,outside) dynamic interface
|
http server enable
http 192.168.45.0 255.255.255.0 management
|
dhcpd auto config outside
dhcpd address 192.168.1.20-192.168.1.254 inside
dhcpd enable inside
|
ip-client outside
|
dns domain-lookup outside
dns server-group DefaultDNS
name-server 208.67.222.222 outside
name-server 208.67.220.220 outside

FXO0S Configuration
The default factory configuration for FXOS on the Firepower 2100 configures the following:
» Management 1/1—IP address 192.168.45.45
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* Default gateway—ASA data interfaces

» Firepower Chassis Manager and SSH access—From the management network only.
« Default Username—admin, with the default password Admin123

* DHCP server—Client IP address range 192.168.45.10-192.168.45.12

* NTP server—Cisco NTP servers: 0.sourcefire.pool.ntp.org, 1.sourcefire.pool.ntp.org,
2.sourcefire.pool.ntp.org

* DNS Servers—OpenDNS: 208.67.222.222, 208.67.220.220
» Ethernet 1/1 and Ethernet 1/2—Enabled

Firepower 4100/9300 Chassis Default Configuration

When you deploy the ASA on the Firepower 4100/9300 chassis, you can pre-set many parameters that let
you connect to the Management interface using ASDM. A typical configuration includes the following settings:

» Management interface:
* Management type interface of your choice defined on the Firepower 4100/9300 Chassis supervisor
* Named “management”
* [P address of your choice
* Security level 0

* Management-only

* Default route through the management interface

» ASDM access—All hosts allowed.

The configuration for a standalone unit consists of the following commands. For additional configuration for
clustered units, see Create an ASA Cluster, on page 439.

interface <management ifc>
management-only
ip address <ip address> <mask>
ipv6 address <ipv6_address>
ipv6 enable
nameif management
security-level 0
no shutdown
!
http server enable
http 0.0.0.0 0.0.0.0 management
http ::/0 management
!
route management 0.0.0.0 0.0.0.0 <gateway ip> 1
ipv6 route management ::/0 <gateway ipvé6>
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ISA 3000 Default Configuration

The default factory configuration for the ISA 3000 configures the following:

» Transparent firewall mode—A transparent firewall is a Layer 2 firewall that acts like a “bump in the
wire,” or a “stealth firewall,” and is not seen as a router hop to connected devices.

« 1 Bridge Virtual Interface—All member interfaces are in the same network (IP address not
pre-configured; you must set to match your network): GigabitEthernet 1/1 (outsidel), GigabitEthernet
1/2 (insidel), GigabitEthernet 1/3 (outside2), GigabitEthernet 1/4 (inside2)

« All inside and outside interfaces can communicate with each other.
» Management 1/1 interface—192.168.1.1/24 for ASDM access.

* DHCP for clients on management.

» ASDM access—Management hosts allowed.

» Hardware bypass is enabled for the following interface pairs: GigabitEthernet 1/1 & 1/2; GigabitEthernet
1/3 & 1/4

N

Note When the ISA 3000 loses power and goes into hardware bypass mode, only the
above interface pairs can communicate; insidel and inside2, and outsidel and
outside2 can no longer communicate. Any existing connections between these
interfaces will be lost. When the power comes back on, there is a brief connection
interruption as the ASA takes over the flows.

» ASA FirePOWER module—All traffic is sent to the module in Inline Tap Monitor-Only Mode. This
mode sends a duplicate stream of traffic to the ASA Firepower module for monitoring purposes only.

* Precision Time Protocol—PTP traffic is not sent to the FirePOWER module.

The configuration consists of the following commands:

firewall transparent

interface GigabitEthernetl/1
bridge-group 1
nameif outsidel
security-level 0
no shutdown

interface GigabitEthernetl/2
bridge-group 1
nameif insidel
security-level 100
no shutdown

interface GigabitEthernetl/3
bridge-group 1
nameif outside?2
security-level 0
no shutdown

interface GigabitEthernetl/4
bridge-group 1
nameif inside2
security-level 100
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no shutdown
interface Managementl/1

management-only

no shutdown

nameif management

security-level 100

ip address 192.168.1.1 255.255.255.0
interface BVIL

no ip address

access-list allowAll extended permit ip any any
access-group allowAll in interface outsidel
access-group allowAll in interface outside2

same-security-traffic permit inter-interface

hardware-bypass GigabitEthernet 1/1-1/2
hardware-bypass GigabitEthernet 1/3-1/4

http server enable
http 192.168.1.0 255.255.255.0 management

dhcpd address 192.168.1.5-192.168.1.254 management

dhcpd enable management

access-list sfrAccessList extended permit ip any any
class-map sfrclass
match access-1list sfrAccessList
policy-map global policy
class sfrclass
sfr fail-open monitor-only
service-policy global policy global

ASAv Deployment Configuration

When you deploy the ASAv, you can pre-set many parameters that let you connect to the Management 0/0
interface using ASDM. A typical configuration includes the following settings:

* Routed or Transparent firewall mode

* Management 0/0 interface:

* Named “management”
* IP address or DHCP

* Security level 0

» Static route for the management host IP address (if it is not on the management subnet)

* HTTP server enabled or disabled

* HTTP access for the management host IP address

* (Optional) Failover link IP addresses for GigabitEthernet 0/8, and the Management 0/0 standby IP address
* DNS server

* Smart licensing ID token
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* Smart licensing Throughput Level and Standard Feature Tier
* (Optional) Smart Call Home HTTP Proxy URL and port

* (Optional) SSH management settings:
* Client IP addresses

* Local username and password

* Authentication required for SSH using the LOCAL database
* (Optional) REST API enabled or disabled

N

Note To successfully register the ASAv with the Cisco Licensing Authority, the ASAv requires Internet access.
You might need to perform additional configuration after deployment to achieve Internet access and successful
license registration.

See the following sample configuration for a standalone unit:

interface Management0/0
nameif management
security-level 0
ip address ip address

no shutdown
http server enable
http managemment host IP mask management
route management management host IP mask gateway ip 1
dns server-group DefaultDNS
name-server ip address
call-home
http-proxy ip address port port
license smart
feature tier standard
throughput level {100M | 1G | 2G}
license smart register idtoken id token
aaa authentication ssh console LOCAL
username username password password
ssh source IP address mask management
rest-api image boot:/path
rest-api agent

See the following sample configuration for a primary unit in a failover pair:

nameif management
security-level 0
ip address ip address standby standby ip

no shutdown
route management management host IP mask gateway ip 1
http server enable
http managemment host IP mask management
dns server-group DefaultDNS
name-server ip address
call-home

Il  ASDM Book 1: Cisco ASA Series General Operations ASDM Configuration Guide, 7.9



| Getting Started with the ASA

Get Started with the Configuration .

http-proxy ip address port port
license smart
feature tier standard
throughput level {100M | 1G | 2G}
license smart register idtoken id token
aaa authentication ssh console LOCAL
username username password password
ssh source IP address mask management
rest-api image boot:/path
rest-api agent
failover
failover lan unit primary
failover lan interface fover gigabitethernet0/8
failover link fover gigabitethernet0/8
failover interface ip fover primary ip mask standby standby ip

Get Started with the Configuration

N

To configure and monitor the ASA, perform the following steps.

Note

Step 1
Step 2

Step 3
Step 4

Step 5
Step 6
Step 7

Step 8

ASDM supports up to a maximum of a 512 KB configuration. If you exceed this amount, you may experience
performance issues. See Increase the ASDM Configuration Memory, on page 34.

Procedure

For initial configuration using the Startup Wizard, choose Wizards > Startup Wizard.

To use the IPsec VPN Wizard to configure IPsec VPN connections, choose Wizards > IPsec VPN Wizard
and complete each screen that appears.

To use the SSL VPN Wizard to configure SSL VPN connections, choose Wizards > SSL VPN Wizard and
complete each screen that appears.

To configure high availability and scalability settings, choose Wizards > High Availability and Scalability
Wizard.

To use the Packet Capture Wizard to configure packet capture, choose Wizards > Packet Capture Wizard.
To display different colors and styles available in the ASDM GUI, choose View > Office Look and Feel.

To configure features, click the Configuration button on the toolbar and then click one of the feature buttons
to display the associated configuration pane.

Note If the Configuration screen is blank, click Refresh on the toolbar to display the screen content.

To monitor the ASA, click the Monitoring button on the toolbar and then click a feature button to display
the associated monitoring pane.
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Use the Command Line Interface Tool in ASDM

This section tells how to enter commands using ASDM, and how to work with the CLI.

Use the Command Line Interface Tool

Step 1

Step 2

Step 3
Step 4
Step 5

This feature provides a text-based tool for sending commands to the ASA and viewing the results.

The commands you can enter with the CLI tool depend on your user privileges. Review your privilege level
in the status bar at the bottom of the main ASDM application window to ensure that you have the required
privileges to execute privileged-level CLI commands.

Before you begin

» Commands entered via the ASDM CLI tool might function differently from those entered through a
terminal connection to the ASA.

» Command errors—If an error occurs because you entered an incorrect command, the incorrect command
is skipped and the remaining commands are processed. A message appears in the Response area to inform
you whether or not any error occurred, as well as other related information.

* Interactive commands—Interactive commands are not supported in the CLI tool. To use these commands
in ASDM, use the noconfirm keyword if available, as shown in the following command:

crypto key generate rsa modulus 1024 noconfirm

* Avoid conflicts with other administrators—Multiple administrative users can update the running
configuration of the ASA. Before using the ASDM CLI tool to make configuration changes, check for
other active administrative sessions. If more than one user is configuring the ASA at the same time, the
most recent changes take effect.

To view other administrative sessions that are currently active on the same ASA, choose Monitoring >
Properties > Device Access.

Procedure

In the main ASDM application window, choose Tools > Command Line Interface.

The Command Line Interface dialog box appears.

Choose the type of command (single line or multiple line) that you want, and then choose the command from
the drop-down list, or type it in the field provided.

Click Send to execute the command.
To enter a new command, click Clear Response, and then choose (or type) another command to execute.

Check the Enable context-sensitive help (?) check box to provide context-sensitive help for this feature.
Uncheck this check box to disable the context-sensitive help.
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Step 6 After you have closed the Command Line Interface dialog box, if you changed the configuration, click
Refresh to view the changes in ASDM.

Show Commands Ignored by ASDM on the Device

This feature lets you show the list of commands that ASDM does not support. Typically, ASDM ignores them.
ASDM does not change or remove these commands from your running configuration. See Unsupported
Commands, on page 87 for more information.

Procedure

Step 1 In the main ASDM application window, choose Tools > Show Commands Ignored by ASDM on Device.
Step 2 Click OK when you are done.

Apply Configuration Changes to Connections

When you make security policy changes to the configuration, all new connections use the new security policy.
Existing connections continue to use the policy that was configured at the time of the connection establishment.
show command output for old connections reflect the old configuration, and in some cases will not include
data about the old connections.

For example, if you remove a QoS service-policy from an interface, then re-add a modified version, then the
show service-policy command only displays QoS counters associated with new connections that match the
new service policy; existing connections on the old policy no longer show in the command output.

To ensure that all connections use the new policy, you need to disconnect the current connections so that they
can reconnect using the new policy.

To disconnect connections, enter one of the following commands:
» clear local-host [ip_address] [all]

This command reinitializes per-client run-time states such as connection limits and embryonic limits.
As a result, this command removes any connection that uses those limits. See the show local-host all
command to view all current connections per host.

With no arguments, this command clears all affected through-the-box connections. To also clear to-the-box
connections (including your current management session), use the all keyword. To clear connections to
and from a particular IP address, use the ip_address argument.

« clear conn [all] [protocol {tcp | udp}] [address src_ip [-src_ip] [netmask mask]] [port src_port
[-src_port]] [address dest_ip [-dest_ip] [netmask mask]] [port dest_port [-dest_port]]

This command terminates connections in any state. See the show conn command to view all current
connections.

With no arguments, this command clears all through-the-box connections. To also clear to-the-box
connections (including your current management session), use the all keyword. To clear specific
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connections based on the source IP address, destination IP address, port, and/or protocol, you can specify
the desired options.
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ASDM Graphical User Interface

This chapter describes how to use the ASDM user interface.

» About the ASDM User Interface, on page 53

* Navigate the ASDM User Interface, on page 56

* Menus, on page 57

* Toolbar, on page 62

* ASDM Assistant, on page 63

* Status Bar, on page 64

* Device List, on page 64

* Common Buttons, on page 65

* Keyboard Shortcuts, on page 66

* Find Function in ASDM Panes, on page 68

* Find Function in Rule Lists, on page 68

* Enable Extended Screen Reader Support, on page 69
* Organizational Folder, on page 69

* Home Pane (Single Mode and Context), on page 70
* Home Pane (System), on page 83

* Define ASDM Preferences, on page 84

* Search with the ASDM Assistant, on page 86

* Enable History Metrics, on page 87

» Unsupported Commands, on page 87

About the ASDM User Interface

The ASDM user interface is designed to provide easy access to the many features that the ASA supports. The
ASDM user interface includes the following elements:

* A menu bar that provides quick access to files, tools, wizards, and help. Many menu items also have
keyboard shortcuts.

* A toolbar that enables you to navigate ASDM. From the toolbar you can access the Home, Configuration,
and Monitoring panes. You can also get help and navigate between panes.

* A dockable left Navigation pane to move through the Configuration and Monitoring panes. You can
click one of the three buttons in the header to maximize or restore this pane, make it a floating pane that
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you can move, hide it, or close it. To access the Configuration and Monitoring panes, you can do one
of the following:

* Click links on the left side of the application window in the left Navigation pane. The Content
pane then displays the path (for example, Configuration > Device Setup > Startup Wizard) in
the title bar of the selected pane.

* If you know the exact path, you can type it directly into the title bar of the Content pane on the
right side of the application window, without clicking any links in the left Navigation pane.

» A maximize and restore button in the right corner of the Content pane that lets you hide and show the
left Navigation pane.

* A dockable Device List pane with a list of devices that you can access through ASDM. You can click
one of the three buttons in the header to maximize or restore this pane, make it a floating pane that you
can move, hide it, or close it.

* A status bar that shows the time, connection status, user, memory status, running configuration status,
privilege level, and SSL status at the bottom of the application window.

* A left Navigation pane that shows various objects that you can use in the rules tables when you create
access rules, NAT rules, AAA rules, filter rules, and service rules. The tab titles within the pane change
according to the feature that you are viewing. In addition, the ASDM Assistant appears in this pane.

The following figure shows the elements of the ASDM user interface.

Il  ASDM Book 1: Cisco ASA Series General Operations ASDM Configuration Guide, 7.9



| Getting Started with the ASA

Figure 1: ASDM User Interface

About the ASDM User Interface .
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GUI Element Description
7 Content Pane
8 Status Bar

\}

Note  Tool tips have been added for various parts of the GUI, including Wizards, the Configuration and Monitoring
panes, and the Status Bar. To view tool tips, hover your mouse over a specific user interface element, such
as an icon in the status bar.

Navigate the ASDM User Interface

To move efficiently throughout the ASDM user interface, you may use a combination of menus, the toolbar,
dockable panes, and the left and right Navigation panes, which are described in the previous section. The
available functions appear in a list of buttons below the Device List pane. An example list could include the
following function buttons:

« Device Setup

* Firewall

* Botnet Traffic Filter
» Remote Access VPN
» Site to Site VPN

« Device Management
The list of function buttons that appears is based on the licensed features that you have purchased. Click each

button to access the first pane in the selected function for either the Configuration view or the Monitoring
view. The function buttons are not available in the Home view.

To change the display of function buttons, perform the following steps:

Procedure

Step 1 Choose the drop-down list below the last function button to display a context menu.

Step 2 Choose one of the following options:
¢ Click Show More Buttons to show more buttons.
« Click Show Fewer Buttons to show fewer buttons.

« Click Add or Remove Buttons to add or remove buttons, then click the button to add or remove from
the list that appears.

« Choose Option to display the Option dialog box, which displays a list of the buttons in their current
order. Then choose one of the following:

* Click Move Up to move up a button in the list.
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* Click Move Down to move down a button in the list.

* Click Reset to return the order of the items in the list to the default setting.

Click OK to save your settings and close this dialog box.

You can access ASDM menus using the mouse or keyboard.

The File menu lets you manage ASA configurations.

File Menu Item

Description

Refresh ASDM with the Running
Configuration on the Device

Loads a copy of the running configuration into ASDM.

Reset Device to the Factory
Default Configuration

Restores the configuration to the factory default.

Show Running Configuration in
New Window

Displays the current running configuration in a new window.

Save Running Configuration to
Flash

Writes a copy of the running configuration to flash memory.

Save Running Configuration to
TFTP Server

Stores a copy of the current running configuration file on a TFTP server.

Save Running Configuration to
Standby Unit

Sends a copy of the running configuration file on the primary unit to
the running configuration of a failover standby unit.

Save Internal Log Buffer to Flash

Saves the internal log buffer to flash memory.

Deploy FirePOWER Changes

Saves configuration changes made to ASA FirePOWER module policies
to the module. This option is available only if you install an ASA
FirePOWER module and manage it through ASDM.

Print

Prints the current page. We recommend landscape page orientation when
you print rules. When you use Internet Explorer, permission to print
was already granted when you originally accepted the signed applet.

Clear ASDM Cache

Removes local ASDM images. ASDM downloads images locally when
you connect to ASDM.

Clear ASDM Password Cache

Removes the password cache if you have defined a new password and
still have a existing password that is different than the new password.
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Clear Internal Log Buffer Empties the syslog message buffer.
Exit Closes ASDM.

View Menu

The View menu lets you display various parts of the ASDM user interface. Certain items are dependent on
the current view. You cannot select items that cannot be displayed in the current view.

View Menu ltem Description

Home Displays the Home view.

Configuration Displays the Configuration view.

Monitoring Displays the Monitoring view.

Device List Displays a list of devices in a dockable pane.
Navigation Shows and hides the display of the Navigation pane

in the Configuration and Monitoring views.

ASDM Assistant Searches and finds useful ASDM procedural help
about certain tasks.

Latest ASDM Syslog Messages Shows and hides the display of the Latest ASDM
Syslog Messages pane in the Home view. This pane
is only available in the Home view. If you do not have
sufficient memory to upgrade to the most current
release, syslog message %ASA-1-211004 is generated,
indicating what the installed memory is and what the
required memory is. This message reappears every
24 hours until the memory is upgraded.

Addresses Shows and hides the display of the Addresses pane.
The Addresses pane is only available for the Access
Rules, NAT Rules, Service Policy Rules, AAA
Rules, and Filter Rules panes in the Configuration
view.

Services Shows and hides the display of the Services pane.
The Services pane is only available for the Access
Rules, NAT Rules, Service Policy Rules, AAA
Rules, and Filter Rules panes in the Configuration
view.

Time Ranges Shows and hides the display of the Time Ranges
pane. The Time Ranges pane is only available for the
Access Rules, Service Policy Rules, AAA Rules,
and Filter Rules panes in the Configuration view.
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View Menu Item

Description

Select Next Pane

Highlights the next pane shown in a multi-pane
display, for example, going from the Service Policies
Rules pane to the Address pane beside it.

Select Previous Pane

Highlights the previous pane shown in multi-pane
displays.

Back Returns to the previous pane.
Forward Goes to the next pane previously visited.
Find in ASDM Locates an item for which you are searching, such as

a feature or the ASDM Assistant.

Reset Layout

Returns the layout to the default configuration.

Office Look and Feel

Changes the screen fonts and colors to the Microsoft
Office settings.

The Tools menu provides you with the following series of tools to use in ASDM.

Tools Menu Item

Description

Command Line Interface

Sends commands to the ASA and view the results.

Show Commands Ignored by ASDM on Device

Displays unsupported commands that have been
ignored by ASDM.

Packet Tracer

Traces a packet from a specified source address and
interface to a destination. You can specify the protocol
and port of any type of data and view the lifespan of
a packet, with detailed information about actions taken
on it. See the firewall configuration guide for more
information.

Ping

Verifies the configuration and operation of the ASA
and surrounding communications links, as well as

performs basic testing of other network devices. See
the firewall configuration guide for more information.

Traceroute

Determines the route that packets will take to their
destination. See the firewall configuration guide for
more information.

File Management

Views, moves, copies, and deletes files stored in flash
memory. You can also create a directory in flash
memory. You can also transfer files between various
file systems, including TFTP, flash memory, and your
local PC.
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Tools Menu Item

Description

Check for ASA/ASDM Updates

Upgrades ASA software and ASDM software through
a wizard.

Upgrade Software from Local Computer

Uploads an ASA image, ASDM image, or another
image on your PC to flash memory.

Downgrade Software

Loads an older ASA image than the one you are
currently running.

Backup Configurations

Backs up the ASA configuration, a Cisco Secure
Desktop image, and SSL VPN Client images and
profiles.

Restore Configurations

Restores the ASA configuration, a Cisco Secure
Desktop image, and SSL VPN Client images and
profiles.

System Reload

Restarts the ASDM and reload the saved configuration
into memory.

Administrator’s Alert to Clientless SSL VPN Users

Enables an administrator to send an alert message to
clientless SSL VPN users. See the VPN configuration
guide for more information.

Migrate Network Object Group Members

If you migrate to 8.3 or later, the ASA creates named
network objects to replace inline IP addresses in some
features. In addition to named objects, ASDM
automatically creates non-named objects for any

IP addresses used in the configuration. These
auto-created objects are identified by the |P address
only, do not have a name, and are not present as
named objects in the platform configuration.

When the ASA creates named objects as part of the
migration, the matching non-named ASDM-only
objects are replaced with the named objects. The only
exception are non-named objects in a network object
group. When the ASA creates named objects for IP
addresses that are inside a network object group,
ASDM retains the non-named objects as well, creating
duplicate objects in ASDM. Choose Tools > Migrate
Network Object Group Members to merge these
object.

See Cisco ASA 5500 Migration to Version 8.3 and
Later for more information.

Preferences

Changes the behavior of specified ASDM functions
between sessions.

ASDM Java Console

Shows the Java console.
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Wizards Menu

Wizards Menu .

The Wizards menu lets you run a wizard to configure multiple features.

Wizards Menu Item

Description

Startup Wizard Guides you, step-by-step, through the initial
configuration of the ASA.
VPN Wizards There are separate wizards for a variety of VPN

configurations. See the VPN configuration guide for
more information.

High Availability and Scalability Wizard

Allows you to configure failover: VPN cluster load
balancing, or ASA clustering on the ASA.

Unified Communication Wizard

Enables you to configure unified communication
features, such as an IP phone, on the ASA. See the
firewall configuration guide for more information.

ASDM ldentity Certificate Wizard

When using Java 7 update 51 and later, the ASDM
Launcher requires a trusted certificate. An easy
approach to fulfill the certificate requirements is to
install a self-signed identity certificate. You can use
Java Web Start to launch ASDM until you install a
certificate using this wizard. See
http://www.cisco.com/go/asdm-certificate for more
information.

Packet Capture Wizard

Allows you to configure packet capture on the ASA.
The wizard runs one packet capture on each ingress
and egress interface. After you run the capture, you
can save it on your computer, and then examine and
analyze the capture with a packet analyzer.

Window Menu

The Window menu enables you to move between ASDM windows. The active window appears as the selected

window.

Help Menu

The Help menu provides links to online help, as well as information about ASDM and the ASA.

Help Menu ltems

Description

Help Topics

Opens a new browser window to show the ASDM
online help. If you are managing an ASA FirePOWER
module in ASDM, this item is labeled ASDM Help
Topics.
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Help Menu ltems

Description

ASA FirePOWER Help Topics

Opens a new browser window to show online help
for the ASA FirePOWER module. This item is
available only if you have installed the module and
are managing it in ASDM.

Help for Current Screen

Opens context-sensitive help about the screen you are
viewing. Alternatively, you can also click the ? Help
button in the tool bar.

Release Notes

Opens the most current version of the ASDM release
notes on Cisco.com. The release notes contain the
most current information about ASDM software and
hardware requirements, and the most current
information about changes in the software.

Cisco ASA Series Documentation

Opens a document on Cisco.com that includes links
to all of the available product documentation.

ASDM Assistant

Opens the ASDM Assistant, which lets you search
downloadable content from Cisco.com, with details
about performing certain tasks.

About Cisco Adaptive Security Appliance (ASA)

Displays information about the ASA, including the
software version, hardware set, configuration file
loaded at startup, and software image loaded at startup.
This information is helpful in troubleshooting.

About Cisco ASDM

Displays information about ASDM such as the
software version, hostname, privilege level, operating
system, device type, and Java version.

The Toolbar below the menus provides access to the Home view, Configuration view, and Monitoring view.
It also lets you choose between the system and security contexts in multiple context mode, and provides

navigation and other commonly used features.

Toolbar Button Description

Home Displays the Home pane, which lets you view important information about your

Home pane.

ASA such as the status of your interfaces, the version you are running, licensing
information, and performance. In multiple mode, the system does not have a

Configuration
configure that function.

Configures the ASA. Click a function button in the left Navigation pane to

Monitoring
various elements.

Monitors the ASA. Click a function button in the left Navigation pane to monitor
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Toolbar Button

Description

Save

Saves the running configuration to the startup configuration for write-accessible
contexts only.

The button is replaced by the Deploy button if you have an ASA FirePOWER
module installed on the device and you are configuring it through ASDM.

Deploy

If you have an ASA FirePOWER module installed on the device and you are
configuring it through ASDM, the Deploy button replaces the Save button and
contains the following options:

* Deploy FirePOWER Changes—Saves configuration changes made to
ASA FirePOWER module policies to the module.

+ Save Running Configuration to Flash—Writes a copy of the ASA running
configuration to flash memory. This is equivalent to the Save button for
devices that do not include an ASA FirePOWER module.

Refresh

Refreshes ASDM with the current running configuration, except for graphs in
any of the Monitoring panes.

Back

Returns to the last pane of ASDM that you visited.

Forward

Goes forward to the last pane of ASDM that you visited.

Help

Shows context-sensitive help for the screen that is currently open.

Search

Searches for a feature in ASDM. The Search function looks through the titles of
each pane and presents you with a list of matches, and gives you a hyperlink
directly to that pane. Click Back or Forward to switch quickly between two
different panes that you found.

ASDM Assistant

The ASDM Assistant lets you search and view useful ASDM procedural help about certain tasks. This feature
is available in routed and transparent modes, and in the single and system contexts.

ChooseView > ASDM Assistant > How Do 1? or enter a search request from the Look For field in the menu
bar to access information. Choose How Do 1? from the Find drop-down list to begin the search.

To use the ASDM Assistant, perform the following steps:

Procedure

Step 1 Choose View > ASDM Assistant.

The ASDM Assistant pane appears.

Step 2 Enter the information that you want to find in the Search field, then click Go.

The requested information appears in the Search Results pane.
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Step 3 Click any links that appear in the Search Results and Features areas to obtain more details.

Status Bar

The Status Bar appears at the bottom of the ASDM window. The following table lists the areas shown from

left to right.

Area Description

Status The status of the configuration (for example, “Device
configuration loaded successfully.”)

Failover The status of the failover unit, either active or standby.

User Name The username of the ASDM user. If you logged in
without a username, the username is “admin.”

User Privilege The privilege of the ASDM user.

Commands Ignored by ASDM Click the icon to show a list of commands from your
configuration that ASDM did not process. These
commands will not be removed from the
configuration.

Connection to Device The ASDM connection status to the ASA.

Syslog Connection The syslog connection is up, and the ASA is being
monitored.

SSL Secure The connection to ASDM is secure because it uses
SSL.

Time The time that is set on the ASA.

Connection to Device

ASDM maintains a constant connection to the ASA to maintain up-to-date Monitoring and Home pane data.
This dialog box shows the status of the connection. When you make a configuration change, ASDM opens a
second connection for the duration of the configuration, and then closes it; however, this dialog box does not
represent the second connection.

Device List

The Device List is a dockable pane. You can click one of the three buttons in the header to maximize or restore
this pane, make it a floating pane that you can move, hide it, or close it. This pane is available in the Home,
Configuration, Monitoring, and System views. You can use this pane to switch to another device, and between
the System and contexts; however, that device must run the same version of ASDM that you are currently
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Step 1

Step 2
Step 3
Step 4

Step 5

Common Buttons .

running. To display the pane fully, you must have at least two devices listed. This pane is available in routed
and transparent modes, and in the single, multiple, and system contexts.

To use this pane to connect to another device, perform the following steps:

Procedure

Click Add to add another device to the list.
The Add Device dialog box appears.
Enter the device name or IP address of the device, then click OK.

Click Delete to remove a selected device from the list.
Click Connect to connect to another device.

The Enter Network Password dialog box appears.

Enter your username and password in the applicable fields, then click Login.

Common Buttons

Many ASDM panes include buttons that are listed in the following table. Click the applicable button to
complete the desired task:

Button Description

Apply Sends changes made in ASDM to the ASA and applies
them to the running configuration.

Save Writes a copy of the running configuration to flash
memory.

Reset Discards changes and reverts to the information

displayed before changes were made or the last time
that you clicked Refresh or Apply. After you click
Reset, click Refresh to make sure that information
from the current running configuration appears.

Restore Default Clears the selected settings and returns to the default
settings.

Cancel Discards changes and returns to the previous pane.

Enable Displays read-only statistics for a feature.

Close Closes an open dialog box.

Clear Remove information from a field, or remove a check

from a check box.

Back Returns to the previous pane.
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Button Description
Forward Goes to the next pane.
Help Displays help for the selected pane or dialog box.

Keyboard Shortcuts

You can use the keyboard to navigate the ASDM user interface.

The following table lists the keyboard shortcuts you can use to move across the three main areas of the ASDM

user interface.

Table 2: Keyboard Shortcuts Within the Main Window

To display the Windows/Linux Mac0S

Home Pane Ctrl+H Shift+Command+H
Configuration Pane Ctrl+G Shift+Command+G
Monitoring Pane Ctrl+M Shift+Command+M
Help F1 Command+?

Back Alt+Left Arrow Command+]|
Forward Alt+Rightarrow Command+]
Refresh the display F5 Command+R

Cut Ctrl+X Command+X

Copy Ctrl+C Command+C

Paste Ctrl+V Command+V

Save the configuration Ctrl+S Command+S
Popup menus Shift+F10

Close a secondary window Alt+F4 Command+W

Find Ctrl+F Command+F

Exit Alt+F4 Command+Q

Exit a table or text area

Ctrl_Shift or Ctrl+Shift+Tab

Ctril+Shift or Ctrl+Shift+Tab

The following table lists the keyboard shortcut you can use to navigate within a pane.

Il  ASDM Book 1: Cisco ASA Series General Operations ASDM Configuration Guide, 7.9



| Getting Started with the ASA
Keyboard Shortcuts .

Table 3: Keyboard Shortcuts Within a Pane

To move the focus to the Press

Next field Tab
Previous field Shift+Tab
Next field when the focus is in a table Ctrl+Tab
Previous field when the focus is in a table Shift+Ctrl+Tab
Next tab (when a tab has the focus) Right Arrow
Previous tab (when a tab has the focus) Left Arrow
Next cell in a table Tab
Previous sell in a table Shift+Tab
Next pane (when multiple panes are displayed) F6

Previous pane (when multiple panes are displayed) | Shift+F6

The following table lists the keyboard shortcuts you can use with the Log Viewers.

Table 4: Keyboard Short